Site Administration

Site Administrators are the system owners. The Site Administrator can easily establish
access for the members of the organization through the InfoPortal’s fast configuration
and simple user interface. Site Administrators are able to override Content Publisher
settings and locks. They are able to perform optimization, batch updates, and back-up
operations on collections.

Site Administrators have access to all of the same features as Content Publishers when
logged in as Site Administrator. However, Site Administrators have additional features
at their disposal, including:

Change the Site Administrator password
Define new Users or Groups for the system
Modify Users and Groups:

- Add, delete, and modify user information
- Add, delete, and modify group information
- Change passwords, including administrators

Make system configuration changes.

- Set system agent information

- Set version history control settings

- Include or exclude uploadable file types

- Set and change link management options

- Makedistributed searches available to Content Publishers and/or users
- Select authentication parameters for InfoPortal implementation

- Arrange for mail forwarding, filtering, and ordering in InfoPortal

Handle system maintenance:

- View collection settings

- Schedule database backups

- Optimize collection performance

- Index help and make it available to system users

- Batch index metadata and/or batch version system files

- Add, view, and modify Extranet information

Manipulate metadata

Add and update new system metadata attributes

Delete system attributes

Import and export bulk metadata

Purge all metadata and document indexes

Unlock Content Publisher-locked files

Create version control archive paths

Set Version Control on or off

Select settings for log tracking, extract log information, and view logs
Start and delete Discussion Groups

View, set, and remove any and all security settings

View, set, and remove any and all agent settings

Install, configure, and test Glyphica Satellite Servers used for PDF generation and
Palm Pilot operations
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Interface Description

Interface Description

When you log in to InfoPortal with the Site Administrator ID and password, the My
Portal view displays:
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See“My Portal,” page 2.1 for adescription of the parts of the My Portal view.

When you select Site Administration from the Show menu, the Site Administration
view displays:
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Site Administration Side Navigation Bar

The Site Administrators screen contains the following areas:

e Side Navigation Bar
e Top Navigation Bar

Site Administration Side Navigation Bar
The Side Navigation Bar islocated on the left-hand side of the Site Administration

Screen:

GLYPHICA

tes

Batch Operations

e User menu

e Group menu

e Configuration menu

¢ Maintenance menu

o Satellite Servers menu
e Logs menu

e Attributes menu

e Batch Operations menu

step task instructions

The Side Navigation Bar contains the following items:

Menu items that contain a submenu display agreen triangle

B (o theleft of the menu name. Thefollowi ng tableslist the
menus in the Side Navigation Bar, a description of each, and
where you can find the relevant user manual sections step-by-

User Menu
Menu Item Description Associated Tasks
Create Displays the User ID screen, where  “Creating a User,” page
you can create users and passwords, 4.13
assign profiles, and assign the user to
one or more groups.
Find/Edit Displays the Search Users screen, » “Finding a User,” page

where you can search for users by
login ID, first name or last name.

4.17
« “Editing a User Profile,”
page 4.18

Group Menu

Menu Item

Description

Associated Tasks

Create

Displays the Group ID screen, where
you can create groups and assign
users to groups.

« “Creating a Group,” page
4.24
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Group Menu

4.4

InfoPortal

Menu Item Description Associated Tasks
(Continued)

Find/Edit Displays the Search Groups screen,  “Finding a Group,” page
where you can search for users by 4.28

login ID or display name.  “Editing a Group,” page
4.29

The following default groups are shipped with InfoPortal 3.0:

Group ID Group Name

intranet Intranet

authors Content Publishers

subadmins Account Administrators

acctmanagers Account Managers

administrators Site Administrators

extranets Extranets

external External Users

allusers Authenticated users

anyone All (Authenticated and Nonauthenticated) users

Thefollowing graphic illustrates the hierarchy of permission rights these groups have:

anyone
anonymous allusers
~
~
~
~
~
external ) ~ .
intranet new groups
extranets
administrators acctmanagers authors

(Account Management)

subadmins
(Account Administration)

admin




Group rights are inherited—that is, user “admin” is also “administrator,” “ subadmin,”
and “author.” Likewise, a member of the “authors’ group inherits “intranet” rights as
well. These relationships are used in access controls.

Configuration Menu

Any time you use a function in the Configuration menu, you must restart the web
server for the changes to take effect. The following table cross-references the
appropriate procedures for supported servers and platforms:

Server Platform Task

Netscape Enterprise ~ Windows NT 4.0 “Stopping and Starting Netscape Enterprise

Server 3.5.1 Server Running on Windows NT,” page 4.64

Internet Information Windows NT 4.0 “Stopping and Starting an Internet Information

Server Server (ISS) Running on Windows NT,” page
4.65

Netscape Enterprise  Solaris 2.6, 2.7 “Starting and Stopping a Netscape Enterprise

Server 3.5.1 Server Running on Solaris,” page 4.66
Menu Item Description Associated Tasks
Agents Displays the Agent Configuration » “Modifying the Portal

Version Control

Content Management

screen, where you can change the Agent Configuration,”
SMTP server and email account page 4.30
information.

Displays the Version Control screen, “Setting the Version

where you can change the version Repository Directory,”

repository directory path and set ver- page 4.31

sioning by default. “Configuring Versions by
Default,” page 4.32

Displays the Content Management “Setting Forbidden File
screen, where you can set the file Extensions,” page 4.33
extensions that the system will block

from uploading, or renaming files to

give them such extensions. This pre-

vents security violations that could

occur when a user uploads a script

or program.

Configuration Menu

InfoPortal
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Configuration Menu

Menu Item Description Associated Tasks
(Continued)

Link Management Displays the Link Management  “Configuring Link Hyper
screen, where you can change the Management,” page 4.34
automatic link management settings
for PDF and HTML documents.
InfoPortal maintains a list of 1) All the
links in a given document; 2) All the
links that point to that document. The
following are the parameters you can
set:

Fix current
When you move a document, the
links in that document will be
updated so that any of them that
were valid would still be valid.

Fix all
When you move a document, all
of the valid links in it and the links
in all of the documents that target
it are updated.

Refresh status
This option causes all other docu-
ments to correct their links in rela-
tion to added or copied
documents.

Manage by default
This option means that all of the
copied and added documents
have their links validated as part
of the add or move (cut) process.

Distributed Search Displays the Distributed Search * “Creating a Distributed
screen, where you can set up, mod- Search,” page 4.34
ify, or delete a server address for a » “Modifying a Distributed
distributed search across the net- Search,” page 4.36
work.  “Deleting a Distributed

Search,” page 4.37

Authentication Displays the Authentication screen, * “Configuring Authentica-
where you can set up and change tion,” page 4.39
the settings for Glyphica, NT, and
LDAP for user authentication.

Post Office Displays the E-Mail Delivery and * “Creating and Changing
Receipt screens, where you can set the E-Mail Delivery Config-
up and change the settings for the uration,” page 4.48

server e-mail account and postmen.
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Menu Item
(Continued)

Description

Associated Tasks

Mailboxes

Displays the Create New Filter
screen, where you can create mail-
box filters. Mailbox filters relay mail
from one mailbox to another. Mail-
boxes contain the extension .mbx.
Attached messages, inline images,
and other non-text/non-HTML con-
tent are broken out into separate
documents. These documents are
indexed separately when the mes-
sage arrives at its final destination. In
addition to indexing mail, you can

search on it and apply metadata to it.

* “Creating a Mailbox Fil-
ter,” page 4.55

Maintenance Menu

Menu ltem

Description

Associated Tasks

System Info

Backup

Displays the Collection Information
screen, including information about the
database collection. Information
includes database software version,
total documents, database creation
date and time, last modification date
and time, and resource values.

Displays the List of Scheduled Back-
ups screen, where you can add,
remove, modify, and stop automatic
backups. The List also shows the
backup process name, the number of
times to repeat the process, the startup
time, and when the process has com-
pleted. Each backup is placed in a sep-
arate folder in the directory you
specified. The folder's name is desig-
nated in a year/month/day format, for
example <backup19990729>, where
1999 is the year, 07 is the month and
29 is the day.

* “Viewing System Informa-
tion,” page 4.59

» “Creating a Backup
Schedule,” page 4.60

Maintenance Menu
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Maintenance Menu

Menu Item Description Associated Tasks
(Continued)

Optimize Displays the Optimize Collection  “Optimizing the Search
screen, where you can optimize the Index,” page 4.67
search index by performing various
functions on it.

The following are the parameters you

can set:

Do maximal merging
Performs merging of the partitions to
create partitions that are as large as
possible. This creates partitions that
can have as many as 65,000 docu-
ments in them. It is faster to search
over a single partition when the
search engine has to open only one
file.

Squeeze deleted documents out of

the search index
Recovers space, which improves
search performance.

Optimize
Linearizes the index data, making it
more streamlined. It also allows the
index to grow to a much larger size.
In effect, Optimize sacrifices some
disk space to get faster searches.
InfoPortal runs the Optimize feature
every night at midnight.

Create spanning word list
Creates one word list across all
index partitions. Like Optimize, this
function trades off disk space for
greater speed.

Do maximal cleanup
Performs the most comprehensive
housekeeping possible, removing
out-of-date index files. This selec-
tion is recommended only if an iso-
lated index is being prepared for
publication, or if the document data-
base takes up more than 20% of the
space occupied by the documents it

manages.
Help Makes the online help files searchable < “Indexing the Help Files,”
for authors and users. page 4.69
Index Purge Displays the Purge Collection screen, * “Purging the Search
where you can clear all information Index,” page 4.70
from the search index. The documents, e« “Restoring the Database
metadata, and field aliases are left from a Backup,” page 4.64

intact. However, you will not be able to
search on them until the documents
have been indexed again.
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Menu Item
(Continued)

Description

Associated Tasks

Extranets

Displays the Search for Extranets
screen, where the Site Administrator
can search for existing Extranets by
Extranet Name or Extranet ID. The Site
Administrator can then manage the
selected Extranet as an Account
Administrator.

“Finding an Extranet,”
page 5.22

Satellite Servers Menu

Menu Item

Description

Associated Tasks

Initialize

Verify

Add

Modify/Delete

Displays the Initialize Glyphica Satellite

Servers screen, where you can per-

form the following tasks for Glyphica

Satellite Servers:

« Configure Adobe Capture settings

» Configure Adobe Acrobat settings

« Initiate and Configure Satellites

« Compile a list of available Satellite
printers

Displays the Sample Files for PDF
Conversion screen, where you can ver-
ify PDF conversion from various for-
mats using the sample files provided
with InfoPortal.

Displays the View Configured Glyphica
Satellite Servers and Add Glyphica
Satellite Servers screens, where you
can view the current Glyphica Satellite
Server configurations and add new
Satellite servers.

Displays the Modify/Delete Glyphica
Satellite Servers screen, where you
can change Glyphica Satellite Server
settings (hostname/IP address, port
number, and communication mode)
and delete Satellite servers.

“Configuring Adobe Cap-
ture Settings,” page 4.73
“Configuring Adobe Acro-
bat Settings,” page 4.74
“Options: Optimize for
Screen, Optimize for Print,
Optimize for Presslnitializ-
ing and Configuring Satel-
lite Servers,” page 4.74
“Checking Satellite Printer
Availability,” page 4.75

“Testing PDF Conver-
sions,” page 4.76
“Configuring Adobe Cap-
ture Settings,” page 4.73
“Options: Optimize for
Screen, Optimize for Print,
Optimize for Presslnitializ-
ing and Configuring Satel-
lite Servers,” page 4.74

“Viewing Current Satellite
Server Configurations,”
page 4.79

“Adding a Glyphica Satel-
lite Server,” page 4.78

“Viewing Current Satellite
Server Configurations,”
page 4.79

“Deleting Glyphica Satel-
lite Servers,” page 4.81

Satellite Servers Menu
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Logs Menu

Logs Menu

Menu Item Description Associated Tasks

View Displays the Log screen, where you  “Viewing the Log,” page
can view the log entries and set the file 481
length for the view. The view default  “Setting the Log View
setting is the last 2048 bytes in the file. Length,” page 4.82
Maximum bytes viewable is limited by
the system and available memory.

InfoPortal can access up to 2GB of log
data. Log entries are divided into daily
files. You will not see a change in the
log view if you type a larger number
and you are already viewing the entire
log for that day.

Settings Displays the Log Configuration screen, < “Setting the Log Loca-
where you can set the log directory tion,” page 4.84
location and choose the items that will  “Configuring Log Entries,”
be placed in the log. page 4.83

Delete Displays the Log Deletion screen,  “Deleting Log Files,” page
where you can delete one or more log 4.85
files from the list that displays. Log
entries are divided into daily log files.

Extranet Displays the Extranet Log screen, » “Extracting an Extranet

where you can export Extranet usage
information to a file.

Log,” page 4.86

Attributes Menu

Menu Item Description

Associated Tasks

Add/Delete Displays the Add/Delete Attributes
screen, where you can add metadata
fields to or delete them from the entire
database.

Modify Displays the Edit Form screen, where
you can modify the values of existing
metadata fields. You can also hide
existing metadata fields so they do not
display. These actions apply to all of
the documents in the database.

» “Adding Attributes,” page
4.87

» “Modifying Attributes,”
page 4.90 and “Deleting
Attributes,” page 4.91

Batch Operations Menu

Menu Item Description

Associated Tasks

Index Displays the Index Documents screen,
where you can select files for batch
indexing without metadata.
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Import Menu

Menu Item Description Associated Tasks

Version Displays the Batch Versioning screen,  “Batch Versioning Docu-
where you can select files for batch ments,” page 4.96
versioning.

Import Menu

Menu Item Description Associated Tasks
Import Displays the Import Metadata screen, * “Importing Documents and
where the Site Administrator can Metadata,” page 4.99

import documents into InfoPortal from
an existing document management
system or document inventory. The
Site Administrator selects a data-file for
metadata import and picks a base URL
to provide a physical path for compari-

son.

Export Menu

Menu Item Description Associated Tasks

Export Displays the Export metadata screen, » “Exporting Metadata,”
where you can export metadata from page 4.101

the system for reports or importing into
other processing systems. This sends
the metadata as a file under the MIME
type "application/download.” Save it in
your local filesystem when the dialog
box appears, then open it as a text file
(.csv extension).

Content Publishing View

Certain functions in the Content Publishing view are only accessible by Site
Administrators and Account Administrators. Therefore, Content Publishers do not see
these menu items unless they also have Account Administrator or Site Administrator
privileges.

Discussions Menu
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Mailboxes Menu

Although the Discussions option is in the Content Publishing view under File, only
Site Administrators and Account Administrators can create new Discussion Groups.
Therefore, only they can see the Discussion link in the File menu. Discussion Groups
allow Content Publishers and Extranet Usersto interact in a“conversational” mode.
They post messages about a topic to a central location, where others can read those
messages and respond. The messages and responses are grouped in a hierarchical
structure, according to topic, in the Discussion window (see “ The Discussion
Window,” page 3.34 for more information). All Discussion Group postings and
attachments to those postings are indexed by InfoPortal and may be searched.

Menu Item Description Associated Tasks
New Discussion f)isplays the New Discussion (-Broup . "§tarting a New DIscus-
screen, where you can set up a discus- sion,” page 4.105

sion group within the current directory

(only Account Administrators and Site

Administrators can create new Discus-
sion Groups).

Mailboxes Menu

The Mailboxes menu lets Account Administrators and Site Administrators view and
configure the criteria by which mail will be forwarded from a selected mailbox to
another mailbox.

You must select afolder or document in the Content Areabefore clicking on the menu
link. If you do not select an item first, you will get an error message similar to the
following:

localhost:82 - [JavaScript Application] [E3

Pleaze select at least one item.
Y'ou have selected O

Menu Item Description Associated Tasks
Add Eorwarding Displays the Set Mail Filter screen, “Adding Mailbox Forward-
where Site Administrators can config- ing,” page 4.104

ure the criteria by which mail will be for-
warded from a selected mailbox to
another mailbox.

View Forwards Displays the Malil Filters screen, a “Viewing Mailbox For-
read-only screen that lists the current wards,” page 4.105
mail forwarding criteria set for a
selected Mailbox folder. This screen
displays the name of the filter, the loca-
tion to which mail is forwarded (Desti-
nation Mailbox), and the Forwarding
Criteria that has been implemented
(Filter).
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Top Navigation Bar

Top Navigation Bar
See “Top Navigation Bar,” page 1.3 for a description of the Top Navigation Bar.

Site Administration Tasks

The Site Administrator's major function is to create/administer the users and groups
within the system and to oversee the basic system stahility.

Note
: You can use alterna-
Creating a User N
When the Site Administrator creates a user or imports a user from another authentication, includ-
authentication system (LDAP, NT, etc.), the primary goal isto define the user's views ing NT, LDAP, and
in the My Portal window and to define what areas of the system the user does or does SOLARISNIS.
not have access to.
This procedure adds a user to the system, using the Glyphica authentication scheme,
and assigns the appropriate functions and views to the user’s profile.
1. Inthe Side Navigation Bar, click on the User menu triangle to expand it.
L Firllj."E-ljit
2. Click on the Create link.
* The Create User screen displays:
Basic Info L. Basic Info Il Profiles Groups
lserid
Fasswaord
Fassword Confirmation
Merd Note
User IDs and pass-
words are case-sensi-

3. Enter the user ID. tivein InfoPortal .
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Creating a User

« ThisistheID the user will always enter to log into InfoPortal.
Enter the password.

Enter the password again to confirm.

Click on the Next button.

Enter the user’sfirst name.

Enter the user’s last name.

Enter the user’'s email address.

Basic Info | Basic Info 1 Profiles Groups

© o N O A

First name
|J|:|hn

Last name
|D|:|e

Email

|jnhn@glyphica.cnm|

et

10. Click on the Next button.

Basic Info | Basic Info Il Profiles

Create the following profiles
Frojects Frojects

Add Farket Mews

Dl
Note z
Profiles define what
windows the user sees
in their My Portal
view. Most InfoPortal MNext
installations will con-
tain alist different
from what you see 11. To add a profile, click on the profile name in the right-hand column.
METE [T, U 12. Click on the Add button
"Projects” profileisa ) ] ’ ) .
window that showsthe 13. To remove a profile from the left-hand column, click on the profile name.
basic contents of the 14. Click on the D€l button.

system.
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15. When finished, click on the Next button.

Basic Info I.

Basic Info Il.

Profiles Groups

Content Fublishers (default)

Set as Default |Add| Bemowe

Sane

16. To add the user to a group (multiple groups are allowed), click on the Add button.

» Thiswill take you to a screen that lets you find existing groups and add them to
this user's profile.

» The Search Groups screen displays in a separate window.

Search Groups

submit |

Group 1D

j ||:|:|ntains j |

17. Input your search criteria. You can search on Group ID or Display Name.
¢ Clicking on the Submit button returns alist of all groupsin the system.
18. Click on the Submit button.

Creating a User

Note

Groups are used to
assign access and
functionality privi-
legesto the user. See
“Group Menu,” page
4.3 for details. In addi-
tion, see“ Security
(filesand folders)
Overview,” page 3.42
for details on how
group membership can
affect accessto the
collection.
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Creating a User

4.16
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» The search results display:

Search Groups

|Gr|:|up 10

Add
Add
Add
Add
Add
Add
Add
Add
Add
Add
Add
Add

*  See“Group Menu,” page 4.3 for atable that lists the default groups shipping
with InfoPortal 3.0 and their respective permissions.

19. Click onthe Add link for each group you want to add.
¢ (The new user is automatically added to the anyone and allusers groups.)
20. Click on the close box ] to close the Search Groups window.
e Thegroup nameis added to the profile:

anyone

extranets Extranets
external External Users
allusers Authenticated users

All (Auth+Monauth) users

j ||:|:|ntains j I Subrmit |
Group 1D Group Mame With LI
SvH Sales VPs
Sk Sales Force
TIM TIM YES
oL oL YES
authars Content Publishing YES
subadmins Account Administration YES
acctmanagers Account Management Yes
administrators  Site Administration YES

Basic Info . Basic Info Il. Profiles Groups
antentpubhghers(defaum ......................................
Turbo Tux
Only Excellent katerial
Account Management
Site Administration
External Users
oetas Default | Addl Femowve

Sane




Finding a User

21. Users are added to the Content publishing group by default, and given that user
interface (my portal, content publishers) automatically.

22. Click on the Set As Default button. Note
23. Click on the Save button. Setting a Default

. . . . Group that has no
A confirmation message displays. interface associated

with it means the user
may not be ableto log
in to InfoPortal.

Lser |d has been created

click here to modify it.

click here to create another.

» Usethe"click here to modify it" link to edit the user you just created. Use the
"click hereto create another" link to create another new user.

Finding a User

This procedure searches for an existing user in the system. It is useful for locating a
distinct user and changing their password (the Site Administrator cannot view user
passwords, only change them if they forget their password). See “ Editing a User
Profile,” page 4.18 for more details.

1. Inthe Side Navigation Bar, click on the User menu triangle to expand it. .

2. Click on the Find/Edit link.
e The Search Users screen displays.

Search Users

|LDgin n] j |c:|:|ntains j | Submit |

3. Enter your search criteria:

» Clicking on the Submit button, without selecting anything, returnsall usersin the
system.

e Searches can be created for Login ID, First name, Last name, or Full name.
» Thefollowing operators are available: contains, begins with, equals.

e Wildcards are allowed in the text box. For example, a search on "Smi?" will
return users with names such as Smith or Smithson. An asterisk (*) alone entered
into the text box returns all usersin the system.

4. Click on the Submit button.
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Editing a User Profile

4.18
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» The search results display:

Search Users

Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit

Login 1D
julie
tammy
tyler
craig
qaary
david
bhp

Een
matthewy
anonymaous
admin

|L|:|gin 0 jlcuntains jl*

Firstname
dulie
Tamrmy
Tyler
raig
=len
David

EBen
M atthew

admin

Lastname
Zallahan
Smith
Smith
Sanders
=len
Zoleman

Swindale
Farsons

submit |

Editing a User Profile

This procedure finds and edits an existing user profile in the system. The Site
Administrator may at any time update the user's profile information, their name,
password, or group memberships.

In the Side Navigation Bar, click on the User menu triangle to expand it. .

|Jzer

w» Create

= Find/Edit

5. Click on the Find/Edit link.

e The Search Users screen displays:

Search Users

|LDgin D j |c:|:|ntains j |

6. Enter your search criteria.

Subrnit |

» Clicking on the Submit button, without selecting anything, returnsall usersin the

system.

e Searches can be created for Login ID, First name, Last name, or Full name.
» Thefollowing operators are available: contains, begins with, equals.




* Wildcards are alowed in the text box. For example, asearch on "Smi?" will
return users with names such as Smith or Smithson. An asterisk (*) alone entered

into the text box returns all usersin the system.

7. Click on the Submit button.

e The search results display:

Search Users

|L|:|gin 0 jlcuntains jl*

Login 1D
Edt julie
Edit  tammy
Edit  tyler
Edt craig
Edt  ggary
Edit  david
Edt bhp
Edt Ben
Edit  matthew
Edit  anonymous
Edt admin

8. Click on the Edit link.

Firstname

Julie
Tamrmy
Tyler
raig
len
David

EBen
M atthew

admin

Lastname

Zallahan
Smith
Smith
Sanders
=len
Zoleman

Swindale
Farsons

submit |

Editing a User Profile
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Deleting a User

e Theuser ID screen displays:

Basic Info I. Basic Info Il Profiles Groups
lserid
julie
Fassword

Fassword Confirmation

Sane Bemowe

9. Click onthe appropriatetab to go to the field(s) you want to change. See*“ Creating a
User,” page 4.13 for details.

10. Make the appropriate changes.
11. Click on the Save button.

Deleting a User

This procedure deletes an existing user in the system. Deleting a user means that the
user is entirely removed from the system; this should only be used when a user leaves
the company or isno longer allowed any access whatsoever into the system. To limit a
user to specific areas of the system without actually removing them from the system,
see “ Security (files and folders) Overview,” page 3.42.

1. See“Finding aUser,” page4.17 for instructions on how to display the user’s profile.
2. Click on the Edit link for the user you wish to delete.
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Changing a User’s Default Group

e Theuser ID screen displays:

Basic Info I. Basic Info Il Profiles Groups
lserid
julie
Fassword

Fassword Confirmation

Sane Bemowe

3. Click on the Remove button.
« A confirmation message displays:

Microsoft Internet Explorer B3

@ Delete uzer julie?
Eancell

4. Click on the OK button.
« A confirmation message displays.

ser julie has been removed.

Changing a User’s Default Group

The Groups to which the user belongs often assign access and functionality privileges
to the user. See “Group Menu,” page 4.3 for details. In addition, see “ Security (files
and folders) Overview,” page 3.42 for details on how group membership can affect
access to system control.

1. See“Finding aUser,” page4.17 for instructions on how to display the user’s profile.
2. Click on the Edit link for the user you wish to change.
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Changing a User’s Default Group

e TheUser ID screen displays:

Basic Info I. Basic Info Il Profiles Groups
lserid
julie
Fassword

Fassword Confirmation

Sane Bemowe

3. Click on the Groups tab.

» The Groups screen displays.

Basic Info . Basic Info Il. Profiles Groups

Caontent Fublishing (default)
Turbo Tux

Only Excellent katerial
Account Management

Site Administration

Set as Default |Add| Bemowe

Sane Bemowe

4. Click on the group name you want for the default.
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e Thishighlights the name.

Basic Info I.

Basic Info Il. Profiles Groups

Caontent Fublishing (default)
Turbo Tux

‘Onky Excellent baterial

Account Management
Site Administration

Set as Default |Add| Bemowe

Sane Bemowe

5. Click on the Set as Default button.
The default tag changes.

Basic Info I.

Basic Info Il. Profiles Groups

Content Fublishing

Turbo Tux

Only Excellent Material (defaulf)
Account Management

Site Administration

Set as Default |Add| Bemowe

Sane Bemowe

6. Click on the Save button.
A confirmation message displays.

Lser julie has been updated

click here to modify it.

Changing a User’s Default Group

Use the "click here to modify it" link to go back and edit the user you just modi-

fied.
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Creating a Group

Creating a Group

This procedure creates a new group in the system. Creating the group isjust the first
step. Once the group is created, you must add users to the group—or as you create
users, add them into the group. See the section on adding users to groups See
“Creating aUser,” page 4.13

7. Inthe Side Navigation Bar, click on the Group menu triangle to expand it. .

8. Click on the Create link.
9. The Create Group screen displays.

Group D

Display Mame

et

10. Enter the group ID.
e The Group ID isthe name that will show in the Search Groups window.

11. Enter the group namein the Display Name field. The Display Name isthe namethat
will be used when adding access controls. This can be any length, and should be
descriptive of the function and membership of the group (examples. Marketing
Executives or Eastern Sales Force).

12. Click on the Next button.
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Creating a Group

* The Members screen displays:

Basic Info Members

Sane

13. If you want to add a group as a member of this new group, click on the Add button
under Groups.

» Please notethat it is possible to add groups to groups. For example, you might
have asmall group called "Sales VPs' and alarger group called "SalesForce." It
might be useful at times to be able to say that any place the SalesForce has
access, the Sales V Ps have access too—so you add the Sales V Ps group to the
SalesForce group. However, the inverse may not be true—so the SalesForce
group should not be added to the Sales V' Ps group.

* You may not add groups together—that is, if you make the Sales V Ps group part
of the SalesForce group, you will not be able to add the SalesForce group to
Sales VPs. Two system-created accounts function this way: you may not add the
allusers group or the anyone group to a newly-created group.

e The Search Groups screen displaysin a separate window.

Search Groups

|Gr|:|up ] j ||:|:|ntains j | Submit |

14. Enter your search criteria.
15. Click on the Submit button.
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Creating a Group

» The search results display:

Search Groups

|Gr|:|up 10 j ||:|:|ntains j I =ubmit |

Group 1D Group Mame With LI
Add  SWP Sales WPs
Add SF Sales Force
Add  TIM TIM YES
Add DL oL YES
Add  authaors Content Publishing YES
Add  subadmins Account Administration YES
Add  acctmanagers Account Management YES
Add  administrators Site Administration YES
Add  extranets Extranets
Add  external External Users
Add  allusers Authenticated users
Add  anyone All (Auth+Monauth) users

16. Click onthe Add link for each group you want to add.
17. Click on the close box I to close the Search Groups window.
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» Thegroup nameis added to the Members list for the new group.

Basic Info Members
Groups
............................................................... =
Del ||SYF (Sales WPs)
Add
=
Users
............................................................... =
Del
Add
=

18. If you want to add one or more users to this new group, click on the Add button

under Users,

Save Rermove

e The Search Users screen displaysin a separate window:

Search Users

|L|:|gin 0 jlcuntains jl

19. Enter your search criteria.
20. Click on the Submit button.

Creating a Group
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Finding a Group

4.28

InfoPortal

» The search results display:

Search Users

Lagin 1D j ||:|:|ntains j | Subrmit |
Login 1D Firstname Lastname

Add  mary flary Thomas

Add  Jack Jack Jones

Add  jane Jdane Smith

Add  john John Ooe

Add  Cunio Zunio T

Add  JohnC John Casey

Add  Craig Zraig McClellan

Add  anonymous

Add  admin admin

21. Click onthe Add link for each user you want to add.
22. Click on the close box ] to close the Search Users window.

* Theuser nameis added to the Members list for the new group.
23. Click on the Save button.

» A confirmation message displays.

Group SalesForce has been updated
click here to modify it.

e Usethe"click here to modify it" link to edit the group you just created.

Finding a Group
This procedure locates a group in the system.
1. Inthe Side Navigation Bar, click on the Group menu triangle to expand it. .

Group

w» Create

» Find/Edit

2. Click on the Find/Edit link.
* The Search Groups screen displays:

Search Groups

|Gr|:|up ] j ||:|:|ntains j | Submit |

3. Enter your search criteria.




Editing a Group

» Clicking on the Submit button, without selecting anything, returnsall usersin the
system.

e Searches can be created for Login ID, First name, Last name, or Full name.

» Thefollowing operators are available: contains, beginswith, equals.

e Wildcards are allowed in the text box. For example, a search on "Smi?" will
return users with names such as Smith or Smithson. An asterisk (*) alone entered
into the text box returns all usersin the system.

4. Click on the Submit button.

» The search results display:

Search Groups

|Gr|:|up 10 j ||:|:|ntains j |Sales Subrmit |

Group 1D Group Mame — With U
Edit SalesForce Sales Force
Edt SalesVPs SalesWPs

Editing a Group
This procedure modifies the information for an existing Group.
1. Inthe Side Navigation Bar, click on the Group menu triangle to expand it. .

Group

w» Create

» Find/Edit

2. Click on the Find/Edit link.
e The Search Users screen displays:

Search Groups

|Gr|:|up ] j ||:|:|ntains j | Submit |

3. Enter your search criteria.

» Clicking on the Submit button, without selecting anything, returnsall usersin the
system.

e Searches can be created for Login ID, First name, Last name, or Full name.
» Thefollowing operators are available: contains, begins with, equals.

e Wildcards are allowed in the text box. For example, a search on "Smi?" will
return users with names such as Smith or Smithson. An asterisk (*) alone entered
into the text box returns all usersin the system.

4. Click on the Submit button.
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» The search results display:

Search Groups

|Gr|:|up 10 j ||:|:|ntains j |Sales Subrmit |

Group 1D Group Mame — With U
Edit SalesForce Sales Force
Edt SalesVPs SalesWPs

5. Click on the Edit link for the group you want to modify.
» The Group screen displays:

Group 1D
SalesForce

Display Mame

|Sa|ea Force

Save Rermove

6. Click on the appropriate tab to go to the field(s) you want to change.
7. Makethe appropriate changes.
8. Click on the Save button.

Modifying the Portal Agent Configuration

This procedure changes the SMTP address of the local email server used by the
Agents function to send notifications. Without correct configuration, the Agents
function will not work.

* The SMTP addressis ususally added during the installation of the InfoPortal
product.
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Setting the Version Repository Directory

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

Configuration

2. Click onthe Agentslink.
e The Agent Configuration screen displays.

Agent Configuration
SMTE
SEIVEL

From
Address:

Ismtp.hest.cnm

Iadministratnr@cnmpanyname.cnm

Lpdate | Reset

3. Click inthe text box of the field you want to change.
4. Makethe appropriate changes.
» Click on the Reset button if you want to revert to the previous information.
5. Click on the Update button.
6. Stop and restart. See “ Stopping and Starting Web Servers,” page 4.64.

Setting the Version Repository Directory

Use this procedure to configure the location of archived (versioned) files. This does
NOT change the repository of the actual documents in the system—these stay in the
main content area of the InfoPortal. However, the archived versions of those
documents are stored separately in this Repository Directory.

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

Control
anagement

2. Click onthe Version Control link.
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Configuring Versions by Default

4.32

» The Version Control screen displays:

Version Control
Repositoryjld: fulyphicadi/data/archive

Wersion by
default: M On

Lpdate | Reset

3. Makethe appropriate changes.

¢ Click on the Reset button if you want to revert to the previousinformation.
4. Click on the Update button.
5. Stop and restart. See “ Stopping and Starting Web Servers,” page 4.64.

Configuring Versions by Default

Use this procedureto tell InfoPortal whether or not to automatically place al
documents in the system under version history control. If thisis set to On, any
information uploaded to the Portal will be placed under version history control,
meaning that duplicate copies of adocument uploaded to the same category in which
it already exists will generate an archive version, rather than overwrite the document
in the system. Likewise, checking in documents will create archive versions. For a
more thorough description of version history control, please see “ Viewing Document
Version History,” page 3.60.

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

2. Click on the Version Contral link.
e The Version Control screen displays.

Version Control
Repositoryjld: fulyphicadi/data/archive

Wersion by
default: M On

Lpdate | Reset

3. Click inthe Version by default field to change it.

» Click on the Reset button if you want to revert to the previous information.
4. Click on the Update button.
5. Stop and restart 4.64.
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Setting Forbidden File Extensions

Setting Forbidden File Extensions

This procedure sets the file extensions that the system will block when users attemt to
upload documents with these extensions, or rename filesto give them such extensions.
This prevents security violations that could occur when a user uploads an ill-behaved

script or program.
1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

2. Click on the Content Management link.
» The Content Management screen displays:

Content Management

Forbidden Extensions: [exe.bat.com, asp,cqi,dilplgtf

The system will block all attempts to upload documents with these extensions, or to
rename files to give them such extensions. This prevents security violations that could occur
when a user uploads an ill-behaved script ar pragram.

Change Forbidden Extensions

3. To add extensions, enter one or more extensions in the Forbidden Extensions field.
Separate each extension with acomma but no spaces.

4. To delete an extension, highlight it and press the Delete key.

5. Click on the Change Forbidden Extensions button.
« A confirmation message displays on the screen:

Content Management

Updating forbidden to exe. bat . com,. asp.cgi.dll.pl.gtf . avi, waw

Forbhidden Extensions: Iexe.bat.c-:-m.asp.cgi.dll.pl.gtf.axri.waxr

The system will block all attempts to upload documents with these extensions, or to
rename files to give them such extensions. This prevents security violations that could occur
when a user uploads an ill-behaved script or program.

Change Forbidden Extensions

6. Stop and restart. See “ Stopping and Starting Web Servers,” page 4.64.
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Configuring Link Hyper Management

Configuring Link Hyper Management
This procedure manages the links leading into and out of PDF and HTML documents.
1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

2. Click on the Link Management link.
e TheLink Management screen displays.

Link Management
Fiz current: ¥ On
Fal W COn
Eefresh Status: M On
Manage by default: W On
Lpdate | Reset

3. Click in the appropriate check boxes to make your changes.

e Fix current: When you move adocument, the links in that document will be
updated so that any of them that were valid would still be valid.

* Fix all: When you move adocument, all of thevalid linksinit and thelinksin all
of the documents that target it are updated to still be valid.

* Refresh Status: Causes all other documentsto correct their links in relation to
added or copied documents. This option is checked by default.

e Manage by default: Causes all copied and added documents to have their links
validated as part of the add or copy process.
» Click on the Reset button if you want to revert to the default setting before the
update.
4. Click on the Update button.
5. Stop and restartthe server. See" Stopping and Starting Web Servers,” page 4.64.

Creating a Distributed Search

Distributed Searches are away of allowing several InfoPortalsto "talk" to each other.
Essentially, it is possible for one InfoPortal to query the repository of another
InfoPortal. Any servers added here are available for query under the Search option.

4.34 InfoPortal




Creating a Distributed Search

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

2. Click on the Distributed Search link. The Distributed Search screen displays:
Distributed Search

Server Address Description

Server Address Description

Save Rermove

3. Click inthe Server Addressfield.

4. Enter the address of the server on which distributed searches will take place.
* Thiscan be either a server name or it can be an |P address.

5. Pressthe Tab key.

6. Enter abrief description of the server (for example name, department, or location) in
the Description field.

» Hereisan example with completed fields:

Distributed Search

Server Address Description

Server Address Description

Irandc\m Itesting machinel

Save Rermove

7. Click on the Save button.
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Modifying a Distributed Search

» The server address and description display in the table below:

Distributed Search

Server Address Description
C random testing machine

Server Address Description

Save Rermove

Modifying a Distributed Search

You can modify only the Description field. If you modify the server address
information, the system will create anew entry in the table.

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

2. Click on the Distributed Search link.
e The Disgtributed Search screen displays.

Distributed Search

Server Address Description
C random testing machine

Server Address Description

Save Rermove

3. Click on the radio button to the |eft of the server information you want to change.
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Deleting a Distributed Search

» The server address and description display in the fields at the bottom of the
screen:

Distributed Search

Server Address Description
& random testing machine
Server Address Description
Irandc\m Itesting machine
Save Rermove

4. Make the appropriate changes to the Description field.
5. Click on the Save button.

Deleting a Distributed Search

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

Configuratian

2. Click on the Distributed Search link.
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Deleting a Distributed Search

» The Distributed Search screen displays:
Distributed Search

Server Address Description
T chaos testing machine 2
T concentric testing maching 3
C elipse testing machine 4
T random testing maching 1
Server Address Description
Save Rermove

3. Click on theradio button to the | eft of the server address you want to delete.

» The server address and description display in the fields at the bottom of the
screen.

Distributed Search

Server Address Description

& chaos testing machine 2

T concentric testing maching 3

C elipse testing machine 4

T random testing maching 1

Server Address Description

Ichac\s Itesting machine 2

Save Rermove

4. Click on the Remove button.
e A confirmation message displays.

206.86.239.40:82 - [JavaScript Application] [E3

@ Are you zure vou want ta remaove the server?

Cancell

5. Click onthe OK button.
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Configuring Authentication

* The server information is removed from the table.

Distributed Search

Server Address Description
T concentric testing maching 3
C elipse testing machine 4
C random testing maching 1
Server Address Description
Save Rermove

Configuring Authentication

InfoPortal 3.0 is ableto useindustry-standard authentication methodsto contoll access
to the system Using NT or LDAP authentication instead of InfoPortals inherent
system means that thier is no need for aredundant darabase of users. InfoPortal will
"check” auserslogin ID and password against an existing NT or LDAP database

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

2. Click on the Authentication link.

» The Authentication screen displays. Three tabs display on this screen: Glyphica,
NT, and LDAP. These are the three authentication methods available. Seethe fig-
ures and tables that follow for details on each screen. The general stepsto follow
are:

Click on the tab for the type of authentication you want to configure.

Follow the instructions on the screen for completing the fields.

Click on the Change Authentication Parameters button at the bottom of the screen.
Stop and restart See” Stopping and Starting Web Servers,” page 4.64.

oo s~ w
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Configuring Authentication

* Theinitial screen displays the default Glyphica server configuration:
Glyphica HNT LDAP

In Glyphica mode, authentication infarmation relies solely on the Glyphica server.

Authentication Mode: |C|:u:|kie j

Basic/Digest Realm: |3lyphica InfoPortal Sencer

Cookie login script: [leginfddagin gt

The authentication mode controls the means by which users are authenticated at login time. Basic uses
HTTF Basic authentication. Digest uses the secure HTTF Digest algarithm, which is used by WebDAW
but is not supported by most web browsers— neither Metscape Mavigator nor Internet Explarer implement
it. BasicOrDigest offers both options. Basic and Digest authentication both display your server's Realm
when prompting the user for their login and password. Cookie stores a cookie on the user's browser to

validate the login session. If you use Cookie authentication and wish to use WebDAY services, make sure
the WebDAY queue overrides the settings on the server.

¥ Cache Lifetime: |ED seconds.

The login cache is a short-term memory cache designed to the load on the database caused by
authentication. If the cache is off, every single web page, image, and script will require a separate hit on
the login database. If the cache is on, each user will generate at most one hit per cache lifetime. Changes
to the user profile will take effect within the cache lifetime.

Password Encoding: INnne vI

User passwords are usually stored in the Glyphica database. By default, they are not encoded in any way.
If you choose Basebd encoding, they will be stored with the same minimal level of security that protects
HTTF Basic authentication. If you choose MDA, the password will be hashed with the same algorthm that
pratects the security of HTTP Digest authentication; SHA-1 will hash the password with the algorithrm used
by LDAP servers to protect their passwords. Choosing Not stored will prevent the passwards from ever
being stored in the Glyphica database. If you choose any encoding other than Hone or Basebd, Digest
authentication (used by most WebDAY clients) will not work at all— the Digest algarithm requires
knowledge of the cleartext of a user's password in order to wark.

Default Groups: [authers

When users are created from profiles in an external authentication database, they are only members of the
allu=sers= group by default. If you wish your externally authenticated users to be able to access the
autharing Ul they will need to be members of a group that has an associated user interface, such as
authors.

Admin User: |

If you set the Admin User, whenever you log in as admin you will be authenticated against that user's
password instead of any admin password that happens to be in the database. This is useful if you have set
the Passward Encoding to "Mot stored”.

Change Authentication Parameters
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Configuring Authentication

 In the Glypica authentation mode, authentication is performed by Glyphica's
Versant database. The following table describes the fields in this screen.

Field Name

Description

Authentication Mode

Basic/Digest Realm

Cookie Login Script

Cache Lifetime

Password Encoding

Default Groups

Admin User

Allows the Site Administrator to determine how user passwords are
stored and transmitted to the server during a user’s browser session.
InfoPortal curently supports Cookie, Basic, Digest, and BasicOrDigest
Authentication Modes.
Cookie stores a cookie on the user’s browser to validate the login
session. If you use Cookie authentication and wish to use WebDAV
services, make sure the WebDAV queue overrides the settings on the
server.
Basic uses HTTP Basic authentication.
Digest uses the secure HTTP Digest algorithm, which is used by
WebDAV but is not supported by most web browsers— neither
Netscape Navigator nor Internet Explorer implement it.
BasicOrDigest offers both options. Basic and Digest authentication
both display your server’s Realm when prompting the user for their
login and password.

Displays the server's name when prompting the user for their login and
password.

Displays the filename of the cookie that is stored on the user’s browser
to validate the login session.

Indicates how long a permission query lasts before the permission
stored in your browser for the current session is resubmitted to the
server for authentication.

Allows variable encryption methods with which to store passwords in the
database. Glyphica allows None, Base64, SHA-1, and MD5.

Indicates the initial group to which the users belong. If this group does
not have a user interface associated with it, it will be difficult for users to
log in.

Allows the Site Administrator to be authenticated by a different account
when loggin in as admin. This is especially useful when using the not
Stored password encoding available with all other authentication types.
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Configuring Authentication

4.42

» Dueto thelength of the NT server configuration screen, it is shown herein two
parts:

Glyphica NT LDAP

In MT mode, the MT authentication database is used to provide authentication for users who have not
been created through the Glyphica user interface.

Default Domain |

By default, the systemn will atternpt to login users to the above domain, Users with names of the format
domain~user will be looked in up the specified domain.

Domain server |

This server will be used to look up group memberships and perfarm bulk imports of users and groups.
Make sure that you include the ~~ front of the machine's name.

Use local groups [

By default, InfoPartal looks for membership in groups on the domain controller. If you set it to use local
groups, it will find the local groups an the server instead.

Logon type INetwnrk vI

Choose the method for perfarming user logins, Hetworlk is the fastest and should suffice for almost all
canfigurations.

Auth Account Login: I
Password: | Again: |

If you wish authentication to be pedformed as a user other than the one operating the service, specify a
lagin here.

InfoPortal

» Thefollowing table describes the fieldsin this part of the screen:

Field Name Description

Default Domain Indicates the domain to which the users using this authentication method
will be logging in.

Domain Server Indicates the actual location from which InfoPortal will receive authenti-
cation if this method is chosen.

Use Local Groups Tells InfoPortal to look for membership in groups based on the local
groups on the server, rather than on the domain controller.

Logon Type Indicates the method for performing user logins. Although Network is the
fastest and should suffice for almost all configurations, InfoPortal also
allows Interactive, Batch and Service methods. We need descriptions for
these four methods.

Auth Account Indicates the user ID and password for performing authentication as a
user other than the one operating the service.




Configuring Authentication

* NT server configuration screen, part two:

Authentication Mode: |C|:u:|kie j

Basi[;."[]igegt Realm: IGh,rphica InfaPartal Senver

Cookie login script: [leginfddagin gt

The authentication mode controls the means by which users are authenticated at login time. Basic
uses HTTP Basic authentication. Digest uses the secure HTTP Digest algorithm, which is used by
WebDAY but is not supported by most web browsers— neither Metscape Navigator nor Internet Explarer
implement it. BasicOrDigest offers both options. Basic and Digest authentication bath display your
server's Realm when prompting the user for their login and password. Cookie stores a cookie on the
user's browser to validate the login session. If you use Cookie authentication and wish to use WebDAY
services, make sure the WebDAY gqueue overrides the settings on the server.

¥ Cache Lifetime: W seconds.

The login cache is a short-term memory cache designed to the load on the database caused by
authentication. If the cache is off, every single web page, image, and script will require a separate hit on
the login database. If the cache is on, each user will generate at most one hit per cache lifetime.
Changes to the user profile will take effect within the cache lifetime.

Password Encoding: INnne vI

User passwords are usually stored in the Glyphica database. By default, they are not encoded in any
way. If you choose Basebd encoding, they will be stored with the same minimal level of security that
pratects HTTP Basic authentication. If you choose MDA, the password will be hashed with the same
algorithm that protects the security of HTTP Digest authentication; SHA-1 will hash the passwoard with
the algarithm used by LDAP servers to protect their passwords. Choosing Not stored will prevent the
passwoards from ever being stored in the Glyphica database. If you choose any encoding ather than
None or Basebd, Digest authentication (used by maost WebDAY clients) will not work at all— the
Digest algarithm requires knowledge of the cleartext of a user's password in order to waork.

Default Groups: [authers

YWhen users are created from profiles in an external authentication database, they are only members of
the allu=ers= group by default. If you wish your externally authenticated users to be able to access
the authoring UI, they will need to be members of a group that has an associated user interface, such
a5 authors.

Admin User: |

If you set the Admin User, whenever you log in as admin you will be authenticated against that user's
password instead of any admin passward that happens to be in the database. This is useful if you have
set the Passward Encoding to "Mot stored”.

Change Authentication Parameters

Database Import: _ Import Users

This will import all users and groups from the authentication database.
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Configuring Authentication

» Thefollowing table describes the fieldsin this part of the screen:

Field Name Description

Authentication Mode  Allows the Site Administrator to determine how user passwords are
stored and transmitted to the server during a user’s browser session.
InfoPortal curently supports Cookie, Basic, Digest, and BasicOrDigest
Authentication Modes.

Cookie stores a cookie on the user’s browser to validate the login
session. If you use Cookie authentication and wish to use WebDAV
services, make sure the WebDAV queue overrides the settings on the
server.

Basic uses HTTP Basic authentication.

Digest uses the secure HTTP Digest algorithm, which is used by
WebDAV but is not supported by most web browsers— neither
Netscape Navigator nor Internet Explorer implement it.
BasicOrDigest offers both options. Basic and Digest authentication
both display your server's Realm when prompting the user for their
login and password.

Basic/Digest Realm Displays the server's name when prompting the user for their login and
password.

Cookie Login Script Displays the filename of the cookie that is stored on the user’s browser
to validate the login session.

Cache Lifetime Indicates how long a permission query lasts before the permission
stored in your browser for the current session is resubmitted to the
server for authentication.

Password Encoding Allows variable encryption methods with which to store passwords in the
database. Glyphica allows None, Base64, SHA-1, and MD5.

Default Groups Indicates the initial group to which the users belong. If this group does
not have a user interface associated with it, it will be difficult for users to
log in.

Admin User Allows the Site Administrator to be authenticated by a different account

when loggin in as admin. This is especially useful when using the Note
Stored password encoding available with all other authentication types.

Database Import Imports all users from the authentication database.
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Configuring Authentication

» Dueto thelength of the LDAP configuration screen, it is shown here in two

parts;

Glyphica NT LDAP

In LOAFP mode, the LDAP database is used to provide authentication for users who have not been
created through the Glyphica user interface.

LDAP Server Host: | FPort: 328 | Secure: [
User hase DN |
Group hase DN |

Password attribute |

Group data: |
User search scope |Eiase DM only j
Group search scope |Eiase DM only j
User filter |
Group filter |

The LDAP URLs below— which actually control the interaction of InfoPortal with the LDAP server— will
reflect the changes you make in the fields above. Any edits to the URLs themselves will override the
fields above until the next time you change one of the abaove fields.

User URL |

Group URL |

LDAP Server Login: |
Password: | Again: [

Certificate DB Path: |
The certificate DB is required in arder to use S50 with LDAP.

» Thefollowing table describes the fields in this part of the screen:

Field Name

Description

LDAP Server

User Base DN

Group Base DN

Password Attribute
Group Data

User Search Scope

Group Search Scope

Indicates the machine on which the LDAP server is located. The port
number is the port to which the LDAP server is installed.

Indicates the Distinguished Name of the user base, where InfoPortal
searches for user information from the LDAP server.

Indicates the Distinguished Name of the group base, where InfoPortal
searches for group information from the LDAP server.

Indicates the variable set for the category password in the LDAP server.
Comma separated list of data fields to pull from the LDSP group info.

Indicates the breadth of InfoPortal’s search for a user in the LDAP direc-
tory. Options are Base DN only, one level down, and anywhere under
Base DN.

Indicates the breadth of InfoPortal’s search for a group in the LDAP
directory. Options are Base DN only, one level down, and anywhere
under Base DN.
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Field Name Description

User Filter Limits searches for specific users within the LDAP directory.

Group Filter Limits searches for specific groups within the LDAP directory.

User URL Lets Site Administrators edit the user URL; this will override the fields

above until the next time one of the above fields is changed.

Group URL Lets Site Administrators edit the group URL; this will override the fields
above until the next time one of the above fields is changed.

LDAP Server Indicates the administrator account of the LDAP directory that gives
InfoPortal permission to access the directory.

Certificate DB Path (Optional) If certificates have been enabled on the LDAP server, this
indicates the path to the certificate database.
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« LDAP configuration screen, part two:

Authentication Mode: |C|:u:|kie j

Basi[;."[]igegt Realm: |Gh,r|:-hica InfaPartal Senver

Cookie login script: |legin/ddagin.gtf

The authentication mode controls the means by which users are authenticated at login time. Basic
uses HTTP Basic authentication. Digest uses the secure HTTP Digest algorithm, which is used by
WebDAY but is not supported by most web browsers— neither Metscape Navigator nor Internet Explarer
implement it. BasicOrDigest offers both options. Basic and Digest authentication bath display your
server's Realm when prompting the user for their login and password. Cookie stores a cookie on the
user's browser to validate the login session. If you use Cookie authentication and wish to use WebDAY
services, make sure the WebDAY gqueue overrides the settings on the server.

¥ Cache Lifetime: [f0  seconds.

The login cache is a short-term memory cache designed to the load on the database caused by
authentication. If the cache is off, every single web page, image, and script will require a separate hit on
the login database. If the cache is on, each user will generate at most one hit per cache lifetime.
Changes to the user profile will take effect within the cache lifetime.

Password Encoding: |Mone -

User passwords are usually stored in the Glyphica database. By default, they are not encoded in any
way. If you choose Basebd encoding, they will be stored with the same minimal level of security that
pratects HTTP Basic authentication. If you choose MDA, the password will be hashed with the same
algorithm that protects the security of HTTP Digest authentication; SHA-1 will hash the passwoard with
the algarithm used by LDAP servers to protect their passwords. Choosing Not stored will prevent the
passwoards from ever being stored in the Glyphica database. If you choose any encoding ather than
None or Basebd, Digest authentication (used by maost WebDAY clients) will not work at all— the
Digest algarithm requires knowledge of the cleartext of a user's password in order to waork.

Default Groups: [authers

YWhen users are created from profiles in an external authentication database, they are only members of
the allu=ers= group by default. If you wish your externally authenticated users to be able to access
the authoring UI, they will need to be members of a group that has an associated user interface, such
a5 authors.

Admin User: |

If you set the Admin User, whenever you log in as admin you will be authenticated against that user's
password instead of any admin passward that happens to be in the database. This is useful if you have
set the Passward Encoding to "Mot stored”.

Change Authentication Parameters

Database Import: _ Import Users

This will import all users and groups from the authentication database.
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» Thefollowing table describes the fieldsin this part of the screen:

Field Name Description

Authentication Mode  Allows the Site Administrator to determine how user passwords are
stored and transmitted to the server during a user’s browser session.
InfoPortal curently supports Cookie, Basic, Digest, and BasicOrDigest
Authentication Modes.

Cookie stores a cookie on the user’s browser to validate the login
session. If you use Cookie authentication and wish to use WebDAV
services, make sure the WebDAV queue overrides the settings on the
server.

Basic uses HTTP Basic authentication.

Digest uses the secure HTTP Digest algorithm, which is used by
WebDAV but is not supported by most web browsers— neither
Netscape Navigator nor Internet Explorer implement it.
BasicOrDigest offers both options. Basic and Digest authentication
both display your server's Realm when prompting the user for their
login and password.

Basic/Digest Realm Displays the server's name when prompting the user for their login and
password.

Cookie Login Script Displays the filename of the cookie that is stored on the user’s browser
to validate the login session.

Cache Lifetime Indicates how long a permission query lasts before the permission
stored in your browser for the current session is resubmitted to the
server for authentication.

Password Encoding Allows variable encryption methods with which to store passwords in the
database. Glyphica allows None, Base64, SHA-1, and MD5.

Default Groups Indicates the initial group to which the users belong. If this group does
not have a user interface associated with it, it will be difficult for users to
log in.

Admin User Allows the Site Administrator to be authenticated by a different account

when loggin in as admin. This is especially useful when using the Note
Stored password encoding available with all other authentication types.

Database Import Imports all users from the authentication database.

Creating and Changing the E-Mail Delivery Configu-

ration

This procedure lets the Site Administrator set up and change the settings for the server
email account.

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.
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2. Click on the Post Officelink.
e TheE-Mail Delivery and Receipt screens display:

E-Mail Delivery

From Address |leri@alyphica.com

SMTP Server Ismtp.best.c-:-m

Change Delivery Information

Receipt

New Postman

Name: | Type: | UME-style mailbox file j

Add Mew Postman |

¢ From Address: the address used if the email delivery system sends mail.

e SMTP Server: the server that provides connectivity for mail sent by agents or
account managers for extranets.

3. Enter the email account address to which mail will be delivered in the From Address
field.

4. Enter the SMTP server address of your Internet Service Provider (1SP), or for your
mail server if your company has an SMTP server in-house.

5. Click on the Change Delivery Information button.
¢ A confirmation message displays.

E-mail configuration updated. You must re-start the weh server for your changes to take
effect.

E-Mail Delivery

From Address |mail@glyphica.com

SMTP Server [smtpbest.com

Change Delivery Information

6. Stop and restart. See” Stopping and Starting Web Servers,” page 4.64.
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Creating or Adding a New Postman

A Postman represents a process that occurs on aregular basis to check a source of
mail, such as amail server, for new arrivals. When new mail has arrived, the Postman
moves the mail from the incoming location to a designated incoming mailbox file.

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

guration

2. Click on the Post Officelink.
e TheE-Mail Delivery and Receipt screens display:

E-Mail Delivery

From Address [david@glyphica.com

SMTP Server Ismtp.best.c-:-m

Change Delivery Information

Receipt

New Postman

Name: | Type: | UME-style mailbox file j

Add Mew Postman

3. Enter the name of the Postman process in the Name text box.

» Thisletsthe Site Administrator give a descriptive labd to the Postman, which
helps in organizing the data output. (exapmle: “ Salesmail”)
4. Select one of the mailbox types from the Type drop-down list.

¢ Thisisthetype of mailbox file from which InfoPortal retrieves mail. The follow-
ing options are available:

Type Explanation
UNIX-style mailbox file Style available on a standard Unix install that handles mail for
the machine.
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Type Explanation
Microsoft SMTP Server A server available with Microsoft Mail Server programs.
Drop Folder

POP3 Network E-mail Client A standard mail protocol type for many mail servers.

5. Click on the Add New Postman button.

¢ The Create New Postman screen displays. The screem will vary depending on
the Postman Type you've chosen. Here is the screen for a POP3 Network E-mail
client:

Create New Postman

This page allows you to create a new postman to retrieve E-mail and deliver it to a
mailbox under InfoPortal's contral.

Name Zales
Postman Type POP3 MNetwork E-mail Client

Destination URI [fsample.mbx

Checking frequency [fo seconds
Server | port f25
Username |
Password |

Password {again) |

Create Mew Postrman

» Hereisthe Create New Postman screen for a Microsoft SMTP Server Drop
Folder:

Postman type Microsoft SMTP Server Drop Folder

Destination mailbox [sample.mts

Check frequency Every [fo | seconds.
Path to drop folder [/drop
Default ™

The default postman is the one which all Account Managers will see when they choose to create a
mailbox.

Change Postman Infarmation Terminate Postman
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452

6. Inthe Destination URI field, enter the mailbox filename to which mail will be for-
warded.

¢ Make sure you include the slash (/) in the name. In addition, mailboxes must
have the .mbx extension on the filename. All mailboxes are created under the
InfoPortal doc root. You can specify different locations under the root by speci-
fying the entire path. Example: /sales/correspsondence/sal esmail.mbx

7. Change the checking frequency if desired.

» The checking frequency is how often this postman will check the source of
emails for new input.

8. If you arecreating aMicrosoft SMTP Server Drop Folder, enter the appropriate path
in the Path to Drop Folder field. Otherwise, skip to Step 9.

e Thismust be an absolute path on the file system of the host machine.

9. Enter the mail server hostname or |P address where the program receiving mail
resides.

10. Change the Port number, if necessary.

11. Enter the username of the person who administrates this Postman process—that is,
the account that has privileges to pick up this mail.

12. Enter the password for that username.
13. Enter the password a second time for confirmation.

« Thefollowing figure shows an example of a completed screen for a POP3 Net-
work E-mail Client Postman:

Create New Postman

This page allows you to create a new postman to retrieve E-mail and deliver it to a
mailbox under InfoPortal's contral.

Name Sales
Postman Type POP3 MNetwork E-mail Client

Destination URI [/Sales.mbx

Checking frequency [fo seconds
Server |hyperstate port 25

Username IAdministrat-:-r

xxxxx

xxxxx

Create Mew Postrman

14. Click on the Create New Postman button.
» A confirmation message displays:

New POP3 Network E-mail Client postman 'Sales’ created.
Pattern: POP3 name=Sales mbox=-Sales.nbx frequency=&0
url=pop: - Addministrator@hyperstate password=admin

15. Stop and restart. See “ Stopping and Starting an Internet Information Server (1SS)
Running on Windows NT,” page 4.65.
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Changing Postman Information
This procedure modifies the settings for an existing Postman process.
1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

Configuration

2. Click on the Post Office link.

e The E-mail Delivery and Receipt screen displays. The figure that follows shows
only the Receipt screen:_

Receipt
Sales - Nowbosman N

Postman type FPOP3 Metwork E-mail Client

Destination mailbox [/5alesiSales.mbx

Check frequency Every 50 seconds.
POP3 UBL pop:~~julie@entropy

Server |entropy , port [25

Username [iuli=

Password |

Password {again) |
Default ™

The default postman is the one which all Account Managers will see when they choose to create a
mailbox.

Change Postman Infarmation Terminate Postman

3. Click on thetab for the Postman process you wish to change.
¢ The Postman configuration information displays.

4. Make the appropriate changes.

5. Click on the Change Postman Information button.
* A confirmation message displays.

6. Restart the web server.

Deleting a Postman

This procedure deletes an existing Postman process from the system.
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1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

Configuration

2. Click on the Post Office link.

e The E-mail Delivery and Receipt screen displays. The figure that follows shows
only the Receipt screen:

Receipt
Sales - Nowbosman N

Postman type FPOP3 Metwork E-mail Client

Destination mailbox [/5alesiSales.mbx

Check frequency Every 50 seconds.
POP3 UBL pop:~~julie@entropy

Server |entropy , port [25

Username [iuli=

Password |

Password {again) |
Default ™

The default postman is the one which all Account Managers will see when they choose to create a
mailbox.

Change Postman Infarmation Terminate Postman

3. Click onthetab for the Postman process you wish to delete.
» The Postman configuration information displays.

4. Click on the Terminate Postman button.
« A confirmation message displays:

Fostman Sales removed.
Y ou must re-start the web server for your changes to take effect.

5. Stop and restart 4.64.
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Creating a Mailbox Filter

This procedure creates a mailbox filter to forward mail, if the filter criteriayou
configure here are met, from one mailbox to another mailbox.

1. Inthe Side Navigation Bar, click on the Configuration menu triangle to expand it.

Configuration

Control
Management

2. Click on the Mailboxes link.
e The Create New Filter screen displays:

Create New Filter

hailbox filters retrieve mail fram one mailbox fwith extension . mbx) and deposit it
in anather mailbox. All attached messages and any inlined images or other
non-text, non-HTML content will be braken out into separate documents and
indexed separately when the message arrives in its final mailbox. A chain of filters
can pass messages from one mailbox to another.

Agent Name |admin's filter agent

The agent name exists only far your own reference when examining the agents set
on the source mailbox.

Source mailbox |

Destination mailbox |

If the destination mailbox does not already exist, the first message delivered there

will create it.
et |

3. If you want to change the default agent name, highlight the text in the Agent Name
field and enter anew name.

e TheAgent Name exists only for your own reference when examining the agents
that are set on the source mailbox.

4. Pressthe Tab key or click in the next field.

5. Enter the mailbox name in which email will be examined for the criteriain the
Source Mailbox field.

» The source mailbox is the mailbox the filter will look to in order to compare its
contents with the filter criteria.

* The source mailbox isaURL and must begin with aslash (/).
6. Enter the location of the recipient mailbox in the Destination Mailbox field.

* Thisiswhere the mail will be forwarded. If the destination mailbox does not
already exigt, the first message delivered there createsiit.

e The source mailbox isa URL and must begin with a dlash (/).
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» Hereisan example of acompleted screen:

Create New Filter

hailbox filters retrieve mail fram one mailbox fwith extension . mb=x) and depaosit it in
another mailbox. All attached messages and any inlined images or other non-text,
non-HTML content will be broken out into separate documents and indexed
separately when the message arrives in its final mailbox. A chain of filters can pass
messages from one mailbox to another.

Agent Name |admin's filter agent

The agent name exists only far your own reference when examining the agents set
on the source mailbox.

Source mailbox I ISales Mailbox.mbe

Destination mailbox I.l'h.ﬂarketing hi ailb oz mibs:

If the destination mailbox does not already exist, the first message delivered there

will create it.
et |

7. Click on the Next button.

4.56 InfoPortal




Creating a Mailbox Filter

» The Set Filter Criteria screen displays:
Set Filter Criteria

Name admin's filter agent
Source mailhox /Sales Hailbox. mbx
Destination mailbox /Marketing Mailbox. mbx

specify the criteria a message arriving in the source mailbox must meet in order to
be transferred to the destination mailbox. This will generate server-side JavaScript in
the text area below, which you may further edit if you wish.

1. Add a comparison.

Header | From j |Equa|5 j |

[T Case-sensitive e"-\ddl

“fou may input any JavaSeript regular expression if you choose "Contains”, "Starks", or "Ends".

Date |Year x| |Equals 2 | —

Maote that in JavaSeript, the month O corresponds to Januany and the weekday O corresponds to Sunday.
“fears are given with two digits for 1900 to 19939, and with four digits othenize.

2. Add a conjunction if you wish to build a more complex filter expression. (Go back
to 1. after adding the conjunction.)

[And] (s o et (1

3. Add parentheses to the filter manually if you wish to adjust the logic.
Filter:

Finish | Undao | Reset |

» The next section describes how to use this screen to build a JavaScript expres-
sion. The expression represents the criteria that a message arriving in the source
mailbox must contain in order to be transferred to the destination mailbox. You
can use the following buttons at any time:

Button Result

Undo Deletes the action(s) after the last Add button was
clicked. You can perform successive Undo actions.

Reset Clears all field selections.

Finish Accepts the current configuration on the screen.

8. Click on thefirst Header drop-down list and select the message header criteria. The
following are the header elements you can select:
e From, To, Subject, Date, Reply-To, Sender

9. Click on the next drop-down list to the right and select a comparison operator. The

following are the available choices:
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» Equals, Does not Equal, Contains, Begins, Ends

10. Enter the appropriate comparison text in the right-hand text box. If you selected
Contains, Starts, or Ends, you may use a JavaScript regular expression in this text
box.

e For example, if you chose "To" and "Equals’ from the drop-down lists, thenin
the text box you would enter the name of a person, such as"John Doe" or
"john@companyname.com."

11. Click inthe check box if the criteria must be case-sensitive.
12. Click on the Add button.
* The server-side JavaScript code displaysin the Filter field:

Filter:
(message . getHeader( 'From') . search(~"John Does-<1) = 0) :J

[~

13. If that is the extent of your criteria, skip to Step 20.

14. Click on thefirst Date drop-down list and select the date criteria that a message
arriving in the source mailbox must contain in order to be transferred to the destina-
tion mailbox. The following are the date elements you can select:
¢ Year, Month, Day, Weekday, Hour, Minute

15. Click on the next drop-down list to the right and select a comparison operator. The
following are the available choices:

» Equals, Does not Equal, Is Greater Than, IsLess Than, |s Greater or Equal, Is
Less or Equal
16. Enter the appropriate JavaScript in the right-hand text box.
» Thefollowing table describes how JavaScript handles date el ements:

Element JavaScript Code

Days Use the numbers 0-6, where 0=Sunday

Months Use the numbers 0-11, where 0=January

Years Use two digits for 1900-1999, four digits otherwise

« For example, let us assume you chose "Month" and "Equals' from the drop-
down lists. In the text box, you could enter the JavaScript number for the month.
For August, you would use"7."

e The server-side JavaScript code displaysin the Filter field:

Filter:
(message . getHeader( 'From') .searchi~"John Doess1) »= :J
0} (me==age . date. getMonthi{) == 7)

[~

17. If that is the extent of your criteria, skip to Step 20.

18. To continue adding criteria, click on the appropriate conjunction button (And, Or,
Not).
19. Repeat Steps 8 through 18 as needed to build your expression.
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*  When you are finished, the Filter field shows the completed expression:

Filter:

(message . getHeader( 'From') .searchi(~"John Does$- 1) = ;I
0 imessage . date.getMonth() == 71 ||

(message . getHeader( 'From') .searchi~"Jane Smith$-1) =

0} (me==age . date. getMonthi{) == 7) ;I

Finish | Undao | Reset |

20. If you need to adjust the logic, add or delete parentheses to the expression in the Fil-
ter field.

21. Click on the Finish button.
« A confirmation message displays:.

Created filter natned 'admmn's filter agent’.

Viewing System Information

The Site Administrator can view the system information in the Collection Information
screen. The information listed here is read-only.

The Collection Information screen displays when the Site Administrator first logs on.
Another way to access this screen isto select Site Administration from the Show
menu. A third way is described below.

1. Inthe Side Navigation Bar, click on the Maintenance menu triangle to expand it.

# Optimize
#» He

2. Click on the System Info link.
» The Collection Information screen displays:

Collection Information

MetEffect's search engine is the Yerity Deweloper's Kit version 2.4.1 patch level 0.

Information About Resources
Total Documents B26 Hame Value
Craated f;-iaah-féguw 02 1999, Charset 5859
S Country Uz
. Thursday, July 03 1993, :
Last Maodified 102313 Dialect us
Language e

Locale MName english_3859
Majar Version 1

Minor ersion 0

Supplier
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Creating a Backup Schedule

This procedure backs up all database data to a specified directory. You can also
specify the intervals at which backups occur.

Note

The InfoPortal Back-
ups only back up the

database; they do not Backup does not back up the documents themselves. You should manually back them
back up the documents up on aregular basis, preferably when the database backup is performed.
i s 1. Inthe Side Navigation Bar, click on the Maintenance menu triangle to expand it.

FI

# Optimize

# Help

# Index Purge
# Extranets

2. Click on the Backup link.
* ThelList of Scheduled Backups screen displays:

List of Scheduled Backups

Name Repeat Start Time Expired
© Random-Monday 1 10004 199913350 V¥
Ao | Femowve | = Stop |

3. Click on the Add button.
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» The Schedule a Backup screen displays:

Schedule a backup

Mame™* |

Directory* |

Overwrite directory: [T
Moty Tsers: |
Database(s}:*lglyphica

Databaze baEkuP‘l Full Backy j
lewel; .

Ezecute Script: | Mo

Backup domments: |

o

©

10.
11.

12.

Scheduling Details

First Occurence Date & Time: [October = [03 =] [1999 =] @ [15 =] hrs |09 =] mins

Fepeat Limit: € Faorever

End after |1 OCCUrERCES

Diaily

D

Repeat Time Interal:

Weekly
Every ||:”:”:| days ||:”:| hrs |3|:| mins

Submit |

Enter a name for the backup schedule process. (Example: <servername> weekly)

Enter the directory path for the backup file. (Example: C:\glyphica\backups)

If you want to back up over an existing backup file of the database in an existing

directory, click in the Overwrite Directory check box. Otherwise, a separate backup

fileis aways created.

Click in the Notify Usersfield.

Enter the user | Ds of those who should be notified when the backup is finished.

Enter the name of the database for this backup schedule. The default database that is

automatically suggested for the backup is glyphica, asthisis the default database

name during theinstall. To remove “glyphica’, select it and delete it, then typein the

name of the database if it deffers from the default install.

Click on the drop-down list for the Database backup level field.

Select alevel from thelist.

e Options: Full Backup (default), Changes since last full backup, and changes
since most recent backup.

If you want to execute a script as part of the backup, type the directory path andfile-

name of the script in the Execute Script text box. For example, you may wish to

backup the documents after performing a backup. If the name of the script you cre-

&
© Bvery [ Maon T Tue Mwed 7 Thu T Fri 7 Sat T Sun
o
.

InfoPortal 4.61




Modifying a Backup Schedule

4.62

InfoPortal

ated to backup the documents was called "documents.bat”" you would enter it here
and then select for it to occur After Backup.

13. Click on the drop-down list to the right of the Execute Script field.
14. Select an item from the list.

e Options: After Backup (default), Before Backup, Only, and No. (Only means
that the backup will NOT backup. The script will only be run.)

15. Click in the Backup Commentsfield.
16. Enter any comments you want associated with the backup.

17. In the Scheduling Details area, select the First Occurrence Date and Time from the
drop-down lists.
18. Click on the radio button for either Forever or End after...occurrences in the Repeat
Limit field.
e If you selected End after...occurrences, type number in the Occurrences box if
you want the backup to happen more than once.
19. Click on the radio button for a Repeat Time Interval.
» Options: Daily, Every [Day of Week], Weekly, Every [Days/Hours/Minutes].
e If you click on Every [Day of Week], also click on the check box to the left of the
day you want. If you click on Every [Days/Hours/Minutes], also enter numbers
in the appropriate text boxes to the left of the time interval you want.

20. Click on the Submit button.
e Thebackup displaysin the List of Scheduled Backups screen.

List of Scheduled Backups

Name Repeat Start Time Expired

© Random-Monday 1 10:04:1999:13:35%.0 3

Add | Remuvel Stu:upl

« After the entire backup cycle completes, the Expired field displays a check mark.

Each backup is placed in a separate folder in the directory you specified. The folder's
name is based on the date when it was run for evample: <backup19990729>, where
1999 isthe year, 07 is the month and 29 is the day.

Modifying a Backup Schedule
This procedure makes changes to an existing backup schedule.
1. Inthe Side Navigation Bar, click on the Maintenance menu triangle to expand it.

# Optimize

# Help

# Index Purge
» Extranets

2. Click on the Backup link.




Stopping a Scheduled Backup

* ThelList of Scheduled Backups screen displays:

List of Scheduled Backups

Name Repeat Start Time Expired

© Random-Monday 1 10:04:1999:13:35%.0 3

Add | Remuvel Stu:upl

3. Click on the radio button to the left of the backup you want to change.
4. Click on the Modify button.

e The Schedule a Backup screen displays with the backup information.
5. Make the appropriate changes.
6. Click on the Submit button.

Stopping a Scheduled Backup

This procedure stops future occurrences of a scheduled backup. It does not remove the
backup process from the List of Scheduled Backups.

1. Inthe Side Navigation Bar, click on the Maintenance menu triangle to expand it.

# Optimize

# Help

# Index Purge
# Extranets

2. Click on the Backup link.
e ThelList of Scheduled Backups screen displays:

List of Scheduled Backups

Name Repeat Start Time Expired

© Random-Monday 1 10:04:1999:13:35:0 3

Add | Remuvel Stu:upl

3. Click on the radio button to the left of the backup you want to delete.
4. Click on the Stop button.
» TheExpired field will display a check mark to show it has stopped.

Removing Scheduled Backup
This procedure removes the selected backup from the List of Scheduled Backups.
1. Inthe Side Navigation Bar, click on the Maintenance menu triangle to expand it.

FI

# Optimize

# Help

# Index Purge
# Extranets
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2. Click on the Backup link.
e ThelList of Scheduled Backups screen displays:

List of Scheduled Backups

Name Repeat Start Time Expired

© Random-Monday 1 10:04:1999:13:35%.0 3

Add | Remuvel Stu:upl

3. Click on the radio button to the left of the backup you want to delete.
4. Click on the Remove button.
* The backup is removed from the List of Scheduled Backups.

Restoring the Database from a Backup

In the unlikely event of a database corruption or catastrophic loss of the database, you
can manually restore the database from backed-up data and files.

Stop the Service
First stop the web server service before running the restored script. See instructions
concerning stopping and starting wab servers below

Running the Script

After stopping the service, run the restoredb script.

1. Select the MS-DOS Command Prompt from the Programs menu.

2. Inthe DOS window, navigate to the glyphicalapps\util\ directory.

3. Enter the following command:
r est or edb <dbname> backupfile
« where dbnane isthe name used while backing up the database.
e glyphica\appsiutil\ is the location of the restoredb script.

4. Once the restoration has been completed, restart the web server.

Stopping and Starting Web Servers

Stopping and Starting Netscape Enterprise Server

Running on Windows NT
To stop the the NES server:
1. Open the Control Panel.
2. Double-click on Services.
3. Scroll through the list and click on the Netscape Enterprise Server 3.5.1 service:
e Example: Netscape Enterprise Server 3.5.1 (<hosthame>)
4. Click on the Stop button.




Stopping and Starting an Internet Information Server (ISS) Running on Windows NT

To start the NES server:

1. Open the Control Panel.

2. Double-click on Services.

3. Scroll through the list and click on the Netscape Enterprise Server 3.5.1 service:
» Example: Netscape Enterprise Server 3.5.1 (<hostname>)

4. Click on the Start button.

5. Click on the Close button.

Stopping and Starting an Internet Information
Server (ISS) Running on Windows NT

To stop thethe IS server:

1. Open the Control Panel.

2. Double-click on Services.

3. Scroll through the list and click on the 11S Admin Server.
» Thefollowing window displays:

Stopping E |
Stop service: 15 Adrmin Service
The following zervices will alzo be stopped. Cergs] |

’mublishj_r_lq Semnvice
Microzaft SMTF Service Help |

World 'wide Web Publishing Service

Do wou wizh to continue?

4. Click onthe OK button. Note

5. Click on the Close button. Always stop
Microsoft Internet

Information Server

To start the |1S server: installation by stop-
1. Open the Control Panel. Note
2. Double-click on Services. Starting the World

3. Scroll through the list and click on the World Wide Web service (usudly lastinthe ~ WideWebservicewill
automatically start the

list). X .
. admin service. How-
4. Click on the Start button. ever, the reverse is not
5. Click on the Close button. true,
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Starting and Stopping a Netscape Enterprise Server
Running on Solaris

There are two ways to manage the Netscape server installation on Solaris. Thefirstis
to log into the admin server created at the time that the server itself was created. The

admin server URL will probably look like the machine's name, acolon (;) and then a
port number. For example:

http://hypertstate:8080

The port number is determined at the time of the server installation. Enter the URL
into your browser. Once on the admin page, there will be agray button that appears
with the name of the machine on that button. Press the button. Inside the next screen,
you have the option to stop the server here. Press Stop here, and you will receive a
success message should it successfully stop. Likewise, you may start it here.

The second way to start and stop the server:
1. Navigate to the netscape server directory.
2. Navigate to Suitespot/https-machinename

3. If themachineisnot set to restart from inittab, and if you are logged in asroot user,
enter:

Jstop

4. If you are logged in as the owner of the files, enter:
stop

5. To start the server when logged in as root, enter:
Jstart

6. To start the server when logged in as the owner of thefiles, enter:
start

NOTE: If you elected to have the Netscape Enterprise Server placed under inittab
during the process of ingtall, this will only temporarily shut down the server—as soon
as the success error message has cleared, the server will automatically restart.

This procedure stops the server when the inittab function has been called:

1. From the Netscape browser, enter the machine name followed by a colon and the
port number of theinstall.
» Example: http://<servername>:8080

2. Enter the username and password set up to administrate the server.

« At thetop of the screen, around the Netscape Server Administration logo, a but-

ton titled “Web Publishing” displays.

Click on the Web Publishing button.

Select “Web Publishing State,” located on the |eft-hand side of the screen.

Switch the Web Publishing server state from on to off.

Click OK.

Select Save.

e Sdect the Save option only!

Click OK.

Click the Server Preferences button.

e Thebutton islocated at the top of the screen, near the Netscape Server Adminis-
tration logo.

10. Verify that the server isin the “off” position.
11. EXxit the Netscape Administrator tool and return to the UNIX console.

No o~

© ®




Optimizing the Search Index

This procedure starts the server when the inittab function has been called:

1. From the Netscape browser, enter the machine name followed by a colon and the
port number of the install.
» Example: http://<servername>:8080

2. Enter the username and password set up to administrate the server.

< At thetop of the screen, around the Netscape Server Administration logo, a but-

ton titled “Web Publishing” displays.

Click on the Web Publishing button.

Sdlect “Web Publishing State,” located on the left-hand side of the screen.

Switch the Web Publishing server state from off to on.

Click OK.

Select Save.

e Select the Save option only!

Click OK.

Click the Server Preferences button.

» Thebutton islocated at the top of the screen, near the Netscape Server Adminis-
tration logo.

10. Verify that the server isin the “on” position.
11. Exit the Netscape Administrator tool and return to the UNIX console.

No oA~ ®

© ©

Optimizing the Search Index

InfoPortal, by default, optimizes the index every night at midnight. Use the Optimize
features below only if you wish to optimize more frequently, or immediately after
adding or deleting alarge number of documents (mass batch index or metadata index
procedure, for example). The default optimization timeis not user configurable.
Please contact Glyphica Technical Support if you require a change in this procedure.

1. Inthe Side Navigation Bar, click on the Maintenance menu triangle to expand it.

2. Click on the Optimize link.

Note

Optimizing a collec-
tion may take along
timefor large numbers
of documents.

Optimization a so may
impact server perfor-
mance during the
Optimization procee-
dure.
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» The Optimize Collection screen displays:

Optimize Collection
You should sgueeze deleted documents out of the search index on a regular basis to save space.

Optimizing a collection may take a long time for large numbers of docurments.

™ Da maximal merging

[T Squeeze deleted documents out of the search index
™ Optimize

™ Create a spanning ward list

" Da a maximal cleanup

Optimize Index

3. Click on the check box to the left of the routines you want to run (you can choose
multiple routines).

¢ Thefollowing table describes the routines:

Routine What It Does

Do Maximal Merging Performs a merging function on the partitions to create partitions
that are as large as possible. Partitions can have as many as
65,000 documents in them. It is faster to search over a single parti-
tion because the search engine opens only one file.

Squeeze Deleted Recovers space in an index and improves search performance.
Dcouments Out of the
Search Index

Optimize Optimizes the databases in the index by linearizing the data and
streamlining the index metadata. It also allows the index to grow to
a much larger size. In effect, Optimize sacrifices some disk space in
favor of faster searches.

Create a Spanning Creates a word list across all the index’s partitions. A database con-

Word List sists of numerous smaller units called partitions, each of which
includes a word list. As with the Optimize function, this selection
trades off disk space for greater speed.

Do a Maximal Cleanup  Performs the most comprehensive housekeeping possible, and
removes out-of-date index files. This selection is recommended
only if an isolated index is being prepared for publication, or if the
document database is taking up more than 20% of the space occu-
pied by the documents it manages.

4. Click on the Optimize Index button.




Indexing the Help Files

» The Collection Information screen displays with messages telling you when opti-
mization is taking place, and when it completes.

Collection Information

Optimizing collection. This may take some time. ..
Search Information optimized.

MetEffect's search engine is the Verity Developer's Kit version 2.4.1 patch level 0.

Information About Resources
Total Docurnents 5 Name Value
Friday, July 02 Charset 8859
Created Lo n
1999 12:43:39 Caurtry us
. Tuesday, July 13 Dialect s
Last Modified 4505 43'28.57 e
Language en

Locale Mame english_5359
ajar “Wersion 1
Minar %ersion O

Supplier

« Depending on the number of documents envolved, the browser window may time
out before optimization is complete. Thisis not a problem--the optimization will
continue even if the browser window is closed.

* You can verify that optimization is complete using the View Logs feature. See
“Viewing the Log,” page 4.81 and look for an entry that state:

‘ O8f23/99 17:12:13 Verbose =earch Optimizng collection: done.

Indexing the Help Files

Use this function to index the Help files into the InfoPortal database. Until this
operation has been completed, the Help files will not be searchable.

1. Inthe Side Navigation Bar, click on the Maintenance menu triangle to expand it.

Maintenance
m Infa.

# Optimize
#» He

2. Click onthe Help link.
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* Thelndex Help Files screen displays:

Index Help Files

fou can make the help files full text searchable by creating the search index
Index Help Files

3. Click on the Index Help Files button.
¢ The Collection Information screen displays after the Help files are indexed..

Collection Information

InfoPortal's search engine is the Verity Developer's Kit version 2.5.1 patch level 0.

Information About Resources
Total Documents 132 NHame Value
Created Ig;?dfgégigg%t 19 Charset fatatate)
P Country L=
. Monday, August 23 Dialect us
Last Modified 4555 17 43.08 Ialet
Language en

Locale Mame english 3859
hajor Wersion 1
Minar “ersion O

Supplier

* You can verify that indexing is complete using the View Logs feature. See
“Viewing the Log,” page 4.81 and look for PDF file entries that state "Index
Complete:"

OB/23/99 174317 Event Index Daocument:
Complete  di\glyphical2\datathelplauthot\usrsrcops. pdf

Purging the Search Index

This procedure clears all information from the search index. Documents, metadata,
and field aliases are | eft intact. You cannot search the collection again until a Batch
Index or Metadata Index has been run, or the database has been restored.

1. Inthe Side Navigation Bar, click on the Maintenance menu triangle to expand it.

Maintenance
AT 1 Info.

# Optimize

2. Click on the Index Purgelink.
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Searching for Extranets

» The Purge Collection screen displays:

Purge Collection Note

Purging the Search Index will clear the search index of all information. The documents, metadata, and field P“rg' ng chinfor-
aliases will be left intact, but you will not be able to search until the metadata has been indexed. mation may take a

long time for large

Purge Index numbers of docu-

ments.

3. Click on the Purge Index button.
* A confirmation message displays:

206_86.239.42 - [JavaScnpt Application]

@ Are pou zure you want to purge the zearch index?

i Cancel |

4. Click onthe OK button.

» The Collection Information screen displays with messages telling you when the
purgeistaking place, and when it completes.

Collection Information

Furging Search information. This may take a little while. ..
Search infarmation purged.

InfoPortal's search engine is the Yerity Developer's Kit version 2.5.1 patch level 0.

Information About Besources
Total Docurments 0 Name Value
Created Iggzrgﬁzaay, August 26 1999 Charset et
o Country LS
Last Modified Thursday, September 16 Dialect us

1999, 143716
Language en

Locale Mame english_3352
Major Yersion 1
Minar “ersion O

Supplier

Searching for Extranets

This procedure allows the Site Administrator to search for Extranets throughout the
Portal. The search results display links so that the Site Administrator can go directly to
the Extranet information to make changes.
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1. Inthe Side Navigation Bar, click on the Maintenance menu triangle to expand it.

# Optimize
# Help

2. Click on the Extranetslink.
e The Search for Extranets screen displays.

Search for Extranets

|E}{tranet 0] j ||:|:|ntains j I Submit |

3. Enter your search criteria.

» Clicking on the Submit button, without selecting anything, returnsall usersin the
system.

e Searches can be created for Extranet ID or Display name.
» Thefollowing operators are available: contains, begins with, equals.

e Wildcards are allowed in the text box. For example, a search on "Smi?" will
return users with names such as Smith or Smithson. An asterisk (*) alone entered
into the text box returns all usersin the system.

4. Click on the Submit button.
» The search results display:

Search for Extranets

Extranet 1D j ||:|:|ntains j I Submit |

Extranet ID Extranet Name Wiith LI
Load Options_Link Options Link Yes
Load Vendor Yendoriet Yes
Load Optionslink OptionsLink Extranet Yes
Load TIM TIM Yes
Load DLJ DLdJ Yes

5. Click onthe Load link to the left of the Extranet you wish to view.

e The Edit Extranet screen displays (Account Administration mode). See section 5
for information concerning managing Extranets.
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Configuring Adobe Capture Settings

This procedure configures Capture settings for TIFF Renditions. TIFF documents are
generally fax or scans of paper documents. They are large files as a general rule.
Converting them to Adobe Acrobat makes them much smaller, and also converts the
text images to text so that the document can be searched.

1. Click on the Satellite Servers menu.

2. Click on the Initialize link.

e Thelnitialize Glyphica Satellite Servers screen displays. The top section of this
screen contains the Capture Settings for TIFF Rendition:

Initialize Glyphica Satellite Servers

Capture Settings For TIFF Rendition

& English TS © German © Dutch © French

© Englsh TE € Ttallan © Spamsh © Swedish

Capture Output Format: © PDEMormal © PDF Image Only & PDF Image + Text
& Most Accurate € More Accurate  © MNormal © Faster
' Fastest

Capture Language:

Capture Performance:

Acrobat 4.0 Settings
Arcrobat 4.0
Optirmization;

Initiate And Configure Satellites

© Optimize for Screen © Optimize for Print - © Optimize for Press

Capabilites |
Thiz operation could take between 0.5 ~ I minutes
Get Available Satellite Printer List

Printer List |

Thiz operation could take between 0.5 ~ O rinutes

3. Click on the radio button for the appropriate Capture Language.
4. Click on the radio button for the appropriate Capture Output Format.
» Thefollowing table lists the avail able options with an explanation of each one:

Format Explanation

PDF/Normal A PDF file in which all text is searchable. The text can be indexed,
searched, and copied. Page formatting and graphics are preserved.
The files are significantly smaller than PDF Image files, which makes
them ideal for online distribution.

PDF Image Only A PDF document with no searchable text (OCR does not run in this
mode). It contains only a bitmap picture of the original document large
file size.

PDF Image + Text A PDF document that combines PDF Normal and Image features. It
contains a a bitmap picture of the original document as well as recog-
nized text that is hidden behind the picture. This results in searchable
text and a document that is identical to the original (such as for legal or
archival purposes).

5. Click on the radio button for the appropriate Capture Performance preference.
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» The Performance preference adjusts the balance between accuracy and process-
ing time. The following table lists the available options with an explanation of

each one:
Format Explanation
Most Accurate Uses every available technigue to recognize words. This option

requires the most processing time.

More Accurate Compromises between the Most Accurate and Normal options.
Normal Compromises between the Most Accurate and Fastest options.
Faster Compromises between the Normal and Fastest options.
Fastest Requires the least processing time, but also produces the most sus-

pects and recognition errors.

Configuring Adobe Acrobat Settings

This procedure configures Acraobat 4.0 optimization settings. Three settings are
available:

1. Click onthe Satellite Servers menu.

2. Click on theInitialize link.

« Thelnitialize Glyphica Satellite Servers screen displays. The middle section of
this screen contains the Capture Settings for TIFF Rendition:

Acrobat 4.0 Settings
@ O P . L~ .
Acrobat 4.0 Optimization: Optinize for Screen Optinize for Print Optinize for
Pres:z
Configure Capabhilities |

Thiz operation could take between 0.5 ~ O rinutes

3. Click on the radio button for the appropriate optimization.
e Options: Optimize for Screen, Optimize for Print, Optimize for Pressinitiaizing

Optimize for Screen  Use this setting for PDF files that will be displayed on the web or an
intranet, or that will be distributed and viewed through an email system.
Settings are usually optimized for 72-dpi screens.

Optimize for Print Use this setting for PDF files that are intended for printers, digital copi-
ers, CD-ROM publishing, or sending to a client as a publishing proof.

Optimize for Press Use this setting for PDF files that will be printed as high-quality final
output.

and Configuring Satellite Servers
This procedure checks the status of the conversion capabilities of the Glyphica
Satellite Servers and permits the Administrator to troubleshoot and restart these
servers.
1. Click onthe Satellite Servers menu.
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Checking Satellite Printer Availability

2. Click onthelnitialize link.
e Thelnitialize Glyphica Satellite Servers screen displays:

Initialize Glyphica Satellite Servers
Initiate And Configure Satellites

Capture Settings For TIFF Rendition
Capture Language: @ EnglishTU3 € German ¢ Dutch € French
"0 English TE. € Ttalian © Spanish € Swedish
Capture Output Format: © PDFMormal © FDF Image COnly & PDF Image + Text
& Most Accurate € More Accurate € MNormal © Faster

Capture Perf ;
apture Performance: . o

Acrobat 4.0 Settings
& Optimize for Screen © Optimize for Print © Optimize for

Acrobat 4.0 Optimization:
Pres:z

Configure Capabhilities |
Thiz operation could take between 0.5 ~ O rinutes

Get Available Satellite Printer List

Printer List |

Thiz operation could take between 0.5 ~ O rinutes

3. Locate the Initiate And Configure Satellites section.
4. Click on the Configure Capahilities button.
» InfoPortal displays a success/failure report at the top of the screen
e Foralist of available capabilities, go to View Logs and view the list that appears
in the log file..

Tnitiate And Configure Satellites SUCCESS!

Checking Satellite Printer Availability
This procedure checks the availability of printers on the Glyphica Satellite Serverslist.

1. Click on the Satellite Servers menu.
2. Click onthelnitializelink.
e Thelnitialize Glyphica Satellite Servers screen displays:

InfoPortal 4.75




Testing PDF Conversions

Initialize Glyphica Satellite Servers
Initiate And Configure Satellites

Capture Settings For TIFF Rendition
Capture Language: @ EnglishTU3 € German ¢ Dutch € French
"0 English TE. € Ttalian © Spanish € Swedish
Capture Output Format: © PDFMormal © FDF Image COnly & PDF Image + Text
& Most Accurate € More Accurate € MNormal © Faster

Capture Perf ;
apture Performance: . o

Acrobat 4.0 Settings
& Optimize for Screen © Optimize for Print © Optimize for

Acrobat 4.0 Optimization:
Pres:z

Configure Capabhilities |
Thiz operation could take between 0.5 ~ O rinutes

Get Available Satellite Printer List

Printer List |

Thiz operation could take between 0.5 ~ O rinutes

Note: Status of network 3. Locate the Get Available Satellite Printer List section.
Conna:tivity to p” nters 4. Click onthe Printer List button.

may affect the reporting  InfoPortal displays a success/failure report at the top of the screen.
and accessibility of » Goto View Logsfor an additional success/failure report

printing capabilities.

Initialize Glyphica Satellite Servers Printer List SUCCess!

Testing PDF Conversions
This procedure checks the PDF conversion capability.

1. Click on the Satellite Servers menu.
2. Click on the Verify link.
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Testing PDF Conversions

e The Sample Files for PDF Conversion screen displays:

Verify PDF conversion

Check? Last try
r MS_Wordjld:,-’glgrphicaaz,-’datax’pdfgentestfwnrdtest.d o
r MS_E}{celjld:,-’glgrphicaaz.-"datafpdfgentestfexceltest. ?
r MS-PowerPointjld:fglyphicaazfdatafpdfgentestx’pnwerpnint ?
r TleId:.-"glyphicaazfdatax’pdfgentestftiftest.ti ?
r HT[‘-.,.-']I_de:,-’glgrphicaazfdatax’pdfgentestftest.html ?
r Te}{tjld:,-’glgrphicaaz,-’datax’pdfgentestftexttest.t ?
r Frame[‘-ﬂal{erjld:.-"'glgrphicaaz.a"datafpdfgentestfframe.fm ?
r Pagehﬂal{erjld:.-"glyphicaﬁzfdatax’pdfgentestx"pmtest.pES ?
r Pogtgcriptjld:,-’glgrphicaﬁzfdatax’pdfgentestx"pstest.ps ?

Check Configuration

3. Click on the check boxes for the native formats you want to test.
4. Click on the Check Configuration button.
» InfoPortal displays asuccess/failure report at the top of the screen:

Test MS-Word to PAf Conversion Success!

Test 3S-Excel to PAf Conversion SUCCes5]

Test ME-Fowerpomt to Pdf Conversion Failed! Failed: Mo Glyphica Satelite Server capable of
rendering dfglyphicad2idata/pdfgentestipowerpointtest ppt to POF . Rendition Cancelled
Test TIF to Pdf Conversion Failed! Failed: conversion of input file
dialyphica_netsatelite\Templtiftest 7026195 tif to output file
diglyphica_netsatelite\Templ 2026198 pdf. Reason: TIFZPDE: Capture Dongle limit cannot
be checked. Check if dongle is present. TIF conversion cancelled..

Test HTML to Pdf Conwersion SUCCes5s]

Test Tesxt to Pdf Conversion SUCCES5]

Test Frameldaker to Pdf Conwersion SUccessl

Test Pagellalcer to Pdf Conversion Failed! Failed: Mo Glyphica Satellite Server capable of
rendering dfglyphicad2idata/pdfgentestipmtest peS to POF . Rendition Cancelled

Test Postscript to Pdf Conversion SUCcess!

¢ Usethisinformation to troubleshoot any conversion issues.

Error Meaning

No Glyphica Satel- Check that the necessary software (Word, Excel, Powerpoint, etc.) is
lite Server capable installed.
of rendering...

Capturedongle limit  Make sure the Adobe Capture hardware key (dongle) is attatched to
cannot be checked the server.
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* Inaddition, the Verify PDF Conversion screen displaysaLast Try column on the
right-hand side of the screen:

Verify PDF conversion

Check? Last try
vl MS_Wordjld:,-’glgrphicaaz,-’datax’pdfgentestfwnrdtest.d o
W MS_E}{celjld:,-’glgrphicaaz.-"datafpdfgentestfexceltest. o
W MS_PowerPOintjld:,-’glgrphicaaz.-"datafpdfgentestx’pnwerpnint b 4
W TleId:.-"glyphicaazfdatax’pdfgentestftiftest.ti ®
W HT[‘-.,.-']I_de:,-’glgrphicaazfdatax’pdfgentestftest.html o
W Te}{tjld:,-’glgrphicaaz,-’datax’pdfgentestftexttest.t o
W Frame[‘-ﬂal{erjld:,-’glgrphicaaz.a"datafpdfgentestfframe.fm o
W Pagehﬂal{erjld:.-"glyphicaazfdatax’pdfgentestx"pmtest.pES ®
W Pogtgcriptjld:,-’glgrphicaﬁzfdatax’pdfgentestx"pstest.ps @

Check Configuration

* Green check marks indicate success; red Xsindicate failure. Thiscolumnis
saved as areference for the next time that the Site Administrator displays the
Verify PDF Conversion screen.

Adding a Glyphica Satellite Server

This procedure adds a Glyphica Satellite Server to the list of available servers. You
must first install the Glyphica Satellite Server software on the remote machine (see
install manual). Satellite server software ai available at additional cost from Glyphica.
1. Click on the Satellite Servers menu.

2. Click onthe Add link.
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» The Add Glyphica Satellite Servers screen displays:

Add Glyphica Satellite Servers

View Currently Configured Glyphica Satellite Servers
=elect a Sate]]ite:lSatellite-1 [localhosttd299%Yebhode] j

Host Mame /TP ﬂddress:llncalhnst

Port Nmnber:|4299

Communication Mode: & WebMode © FileSystem
Add Glyphica Satellite Server

Haost MName / TP Address:l
Port Mumb er:l
Communication Mode: & WebMode © FileSystem
Add
These operations could take between 0.5 ~ O rinutes

3. Click inthe Host Name/IP Address text box in the Add Glyphica Satellite Server
section.

Enter the hostname or | P address of the server.

Press the Tab key.

Enter the server’s Port number in the Port Number text box.

Click on the appropriate radio button in the Communication Mode field.
* WebMode: used for remote Satellite Servers.

« FileSystem: used when the Satellite Server resides on the same machine as the
InfoPortal application.

8. Click on the Add button.

No oA

« InfoPortal displays a success/failure report at the top of the screen.

Add Glyphica Satelite Server SUCCESE]

Viewing Current Satellite Server Configurations

This procedure selects a Glyphica Satellite Server so you can see its current
configuration.

1. Click on the Satellite Servers menu.
2. Click onthe Add link.
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Modifying Satellite Server Settings

» The View Configured Glyphica Satellite Servers screen displays:

Add Glyphica Satellite Servers

View Currently Configured Glyphica Satellite Servers
=elect a Sate]]ite:lSatellite-1 [localhosttd299%Yebhode] j

Host Mame /TP ﬂddress:llncalhnst

Port Nmnber:|4299

Communication Mode: & WebMode © FileSystem
Add Glyphica Satellite Server
Haost MName / TP Address:l
Port Mumb er:l
Communication Mode: & WebMode © FileSystem
Add
These operations could take between 0.5 ~ O rinutes

3. Click on the Select a Satellite drop-down list in the View Currently Configured
Glyphica Satellite Servers section.

4. Select the Satellite Server you want to view.

Modifying Satellite Server Settings

This procedure changes the address and port information in InfoPortal for an existing
Glyphica Satellite Server machine.

1. Click onthe Satellite Servers menu.
2. Click onthe Modify/Delete link.
» TheModify/Delete Glyphica Satellite Servers screen displays:

Modify / Delete Glyphica Satellite Servers

=elect a Sate]]ite:lSatellite-1 [localhosttd299%Yebhode] j
Haost MName / TP ﬂddress:llncalhnst
Port Nmnber:|4299
Communication Mode: & WebMode © FileSystem

hladify Delete
These operations could take between 0.5 ~ O rinutes

Click on the Select a Satellite drop-down list.

Sdlect the Satellite Server you want to modify.

Click in the field you want to change.

Make the appropriate changes.

Click on the Modify button.

« InfoPortal displays a success/failure report at the top of the screen.

No oA~ ®
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Deleting Glyphica Satellite Servers

» Goto View Logsto view any applicable messages
Modify Glyphica Satellite Server SUCCeSS!

Deleting Glyphica Satellite Servers

This procedure removes a Glyphica Satellite Server from the list of available servers.

1. Click on the Satellite Servers menu.
2. Click on the Modify/Déelete link.
« The Modify/Delete Glyphica Satellite Servers screen displays.

Modify / Delete Glyphica Satellite Servers

=elect a Sate]]ite:lSatellite-1 [localhosttd 2094 Yebiode] j

Host Mame /TP ﬂddress:llncalhnst

Port Nmnber:|42 29
Communication Mode: @ Weblode © FileSystem
hladify Delete
These operations could take between 0.5 ~ 5 minutes

3. Click on the Select a Satellite drop-down list

Select the Satellite Server you want to del ete.

5. Click on the Delete button.
» InfoPortal displays a success/failure report at the top of the screen:
e Goto View Logsto view any applicable messages.

»

Delete Glyphica Satellite Server SUCCESE]

Viewing the Log
This procedure displays several types of activities on the server and reports of any
errors encountered during these activities.
1. Click on the Logs menu.
2. Click on the View link.
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* TheLog screen displays the last 2048 bytes of activity on the server.

View: & Log View last [4996 | bytes

Date

09/14/99 10:52:00
0514799 10:53:23
051499 11:12:24
059/14/99 11:12:28
09/14/99 11:12:28
0514799 11:12:38
051499 11:12:28
09/14/99 11:12:28
09/14/99 11:12:28
05/14/99 11:12:40
051499 11:12:40
051499 11:12:40
09/14/99 11:12:40
09/14/99 11:12:40
051459 11:12:40
051499 11:12:44
05/14/99 11:12:44
09/14/99 11:12:44
05/14/99 11:12:44
051499 11:12:44
05/14/99 11:12:44

Lvl Module MMessage

167
285
325
325
325
325
325
325
325
284
284
284
284
284
284
325
325
325
325
325
325

(systetmn)
adrmin
adrmin
adtmin
admin
adrmin
adrmin
admin
admin
adrmin
adrmin
admin
admin
admin
adrmin
adrmin
adtmin
admin
adrmin
adrmin
adtmin

System fireJEvent multiple_synchfire Ban one event

Information Javascript Loading navbar nodes

Information Javascript Loading navbar nodes

Debug Javascript # user: set(extranet, Whdwave)

Debug Javascript # user: set(uiro ot finfoportalfarorld)

Debug Javascript # useriset{cntroot, /fextranethlidwave)

Information Javasciipt content root=extranetMfidwave

Information JTavascrpt redirected to fAnfoportal®world

WVerboze Javascrpt request redirect called, database update won't happen
Debug Tavascript # user:set{extranet Widwawe)

Debug Javascrpt # useriset{uiroot,finfoportalworld)

Debug JTavascript # usernset(ontroot, fextranethlidwave)

Information Javascrpt content root=extranetMlidwave

Information Javaschpt redirected to Anfoportalfworld

Verbose Javascript request.redirect called, database update won't happen
Debug JTavascript # user:set{extranet, Widwave)

Debug Javascript # user:set(uiro ot finfoportalfarorld)

Debug Javascript # user: set(cntroot fextranetMlidwave)

Information Javascript content root=extranet/Midwave

Information Javascript redirected to fmfoportalfworld

Verbose Javaszcript request.redirect called, database update won't happen

Setting the Log View Length

This procedure sets how far back in time the log extends.

1. Click on the Logs menu.
2. Click onthe View link.
¢ Thelog screen displays.




Configuring Log Entries

View: @ Log View last I‘*'Z'E“5 bytes

Date Lvl Module MMessage
021499 10:52:00 167 (system) System firelEvent multiple synchfire Ean one event
09/14/5% 10:52:23 289 admin Information Javascnpt Loading navbar nodes
09/14/59 11:12:34 325 admin Information Javascnpt Loading navbar nodes
09/14/5% 11:12:38 325 admin Debug Tavascript # user:set(extranet Midwawe)
02144599 11:12:38 325 admin Debug JTavascript # user: set{uiro ot finfoportalfaorld)
0201499 11:12:38 325 admin Debug Javascript # user: set{cntroot fextranetMlidwave)
09/14/5%9 11:.12:38 325 admin Information Javascnpt content root=extranetMhdwave
09/14/5%9 11:12:38 325 admin Information Javascrpt redirected to fmfoportalfworld
0214459 11:12:38 323 admin Werboze Tavascript request redirect called, databaze update wo
02/14/99 11:12:40 284 admin Debug Javascript # user: set{extranet, Widwawe)
02014459 11:12:40 284 admin Debug JTavascript # user: set{uiro ot finfoportalfaorld)
09/14/5% 111240 284 admin Debug Tavascript # user:set{cntroot fextranethlidwave)
09/14/39 11:.12:40 284 admin Information Javascnpt content root=fextranetMhdwave
02/14/59 11:12:40 284 admin Information Javascript redirected to fnfoportalferorld
02144599 11:12:40 284 admin Werboze Tavascript request redirect called, database update wo
0201499 11:12:44 325 admin Debug Javascript # user: set{extranet, WMidwawe)
09/14/5% 11.12:44 325 admin Debug Tavascrpt # user;set{uroot, finfoportalfworld)
09/14/5%9 111244 325 admin Debug Tavascript # userset{ontroot fextranethlidwave)
02/14/59 11:12:44 325 admin Information Javascrpt content roct=extranetTlidwave
0201499 11:12:44 325 admin Information Javaschpt redirected to fAnfoportalfwrorld
09/14/5%9 11:12:44 325 admin Werbose Tavascript request redirect called, database update wo

3. Highlight the number in the View last...bytes text box.

4. Enter anew number. For active servers you may have to enter “50000” or a higher
number to see an appreciable timeframe.

5. Click on the Log radio button.

* Thelog view length changes. You will not see achangein the log view if you
type alarger number and you are already viewing the entire log for that day.

Configuring Log Entries
This procedure configures what the system will log.

1. Click on the Logs menu.
2. Click on the Settings link.
» TheLog Configuration screen displays:
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Setting the Log Location

Log Conﬁgura%nn
Log directory: [Di/glyphica/apps/logs
What to log™ [ Fatal Error W Exzception ™ Error
W Event W Access W Access Denied
W Information ¥ WVerbose — M Debug
W System W Tnclassified

Additional Access log entry specifications

Tzer felds to log: |fir5tn ame.lastname, email

Exclude files: |jpg,gif,bmp,gtf
Update Feset

* Sethings take effect after update
Other settings require a server restart.

3. IntheWhat to log section, click on the check boxesfor any items you do not want to
log.
e |If the box is checked, InfoPorta will log entries for that type.

4. If you want additional fields as entries in the Access log, type the field name in the
User fidlds to log text box. Separate each field name with a comma.

5. If you want to exclude additional file types, type the three-letter extension in the
Exclude files text box. Separate each extension with a comma.
¢ Click on the Reset button if you want to revert to the previousinformation.
6. Click on the Update button.

Setting the Log Location

This procedure sets the directory where InfoPortal stores the log files. The default
directory iswhere the InfoPortal software was installed, in /glyphica/apps/logs.

1. Click on the Logs menu.
2. Click on the Settings link.
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» TheLog Configuration screen displays:

Log Conﬁgura%nn
Log directory: [Di/glyphica/apps/logs
What to log™ [ Fatal Error W Exzception ™ Error
W Event W Access W Access Denied
W Information ¥ WVerbose — M Debug
W System W Tnclassified

Additional Access log entry specifications

Tzer felds to log: |fir5tn ame.lastname, email

Exclude files: |jpg,gif,bmp,gtf
Update Feset

* Sethings take effect after update
Other settings require a server restart.

3. Enter the new directory path.
» Click on the Reset button if you want to revert to the previous information.
4. Click on the Update button.

5.) Stop and restart the webserver (section 4.64)

Deleting Log Files
This procedure deletes individual log files.

1. Click on the Logs menu.
2. Click on the Delete link.
* TheLog Deletion screen displays:

Log Deletion

™ 19990828 log
™ 19990906, log
™ 19930910 log
™ 19990914 log
[T 19990921 log
™ 19990923 log
[T 19990928 log
™ 19931001 log
™ 19931015 log

™ 19930904 . log
™ 19990908 log
™ 19990912 log
™ 19990316, log
[T 19990922 log
[T 19990927 log
™ 19990929 log
™ 19931004, log
™ 19931030 log

delete |

3. Click on the check boxes next to the log file you want to delete. You can select mul-
tiplefilesto delete.
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4. Click on the Delete button.

Extracting an Extranet Log

This procedure extracts Extranet access information from a daily log file to areport
file.

1. Click on the Logs menu.
2. Click on the Extranet link.
e The Extranet Log screen displays:

Extranet Log

Input Log File: 19990617 log =]
Ui |
Output CWS File: [ireport.osv

Extract Log

Sdect alog file from the Input Log File drop-down list.
Click in the Uri text box.
Enter the exact path to the required extranet (ie: /extranet/extranetname).

If you want a different report file name than the default (Ireport.csv), highlight the
text in the Output CV S File text box and type a new file name.

7. Click on the Extract Log button.
» Thefileisextracted to the location of your other log files

© 0k w
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Adding Attributes

This procedure allows the Site Administrator to add new metadata fields to the entire
database. Thisfeature is used by the Site Administrator to dynamically extend the
system metadata. The Site Administrator specifies the field attributes. Once specified,
the attribute is avail able for all documents and categories in the database.

1. Inthe Side Navigation Bar, click on the Attributes menu triangle to expand it.

2. Click onthe Add/Ddete link.

» The Add/Delete Attributes screen displays:

Add ! Delete Attributes

144 Text fields available Add |
12 Integer fields available Add |
12 Timestamyp fields available Add |

IMame
*  Author
*  Charset
* Date
* G CATEGORY
* G _COMMENT
* (G_CREATED
* G _LASTMODIFIED
* (G _ORIGINATL
* G _RENDITION
* G BIZE
* 3 TRI
Eeywords
*  NIME-Twpe
HewsGroups
* TPath
PageMap
Srippet
* Title
* To

Database Mame (Alias)
Luthor

Charset

Date

G CATEGORTY
G_COMNMENT

3 _CREATED

G LASTMODIFIED
5 _CORIGIMNAT
G_RENDITION

G _SIZE

3_TIRI

Eeywords
MIME-Tvpe
HewsGroups
WVdkVegwEey (FPath)
PageMap

Srippet

Title

To

* System fields cannot be deleted

Delete Selected Field

Adding Attributes

Note:

InfoPortal includes
certain system-defiend
default metadata
fields.
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3. Decide what type of attribute field you want to add: Text, Integer, or Timestamp.

Field Enter Explanation
Text Alphanumeric characters are allowed in this field.
Integer Only integers are allowed in the field. Any other number entered is

automatically rounded down to the nearest integer. Text entered in the
field results in an error message.

Timestamp A date entered in the field is automatically formatted as YYYY/MM/DD
HH:MM:SS

4. Click on the appropriate Add button.
* The Added Attribute screen displays:

Added Attribute

Attribute added to metadata. Chcl: nest to edit metadata form defintion.

Mext = |

¢ This screen confirms that a metadata field was created.
5. Click on Next.
« Once you've selected add an atttribute, that attribute has been added. You must

configure it and save your changes to its configuration, or it will appear with sys-
tem defaults.

e The Editing Attributes Form screen displays with the new field at the bottom of
the list (the following figure shows only the top section of the screen):

Editing Form: dlyphicaProperties

Display Template Description

I Default | Document Properties =]

[~

Display Mame Field Name {Alias) Format

=l=l=E Author Author Text Field

=== Date Date Text Field

=ll=|3 Description Description Text Field

=l=l=1A Keywords Keywords Text Field

=== Title Title Text Field

===l new_field_t1 _t1 {new_field_t1) Text Field

Save | Rewvert |

6. Click onthe = to theleft of the new field name to configure the field.
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» The Attribute Settings screen displays:

Attribute Settings for _t1

Fretty Marme Inew_field_tl

Collection Alias |HEW_f ield tl

A ocollection alias can be used to make searches easier for human beings to read; they may only be made up of
lettars, dashes, and underscores.

Display Format |Text Field j

Restrictions INnne vI

Darnain I [regular expression)

Layout Specifics: (cheded items apply)
¥ Width |2|:|

[ Height |1
[T Choices ]

[orwe choice per
Tire))

o o
Mext = |

7. Inthe Pretty Namefield, enter the name you want the InfoPortal interface to display.

8. Enter ashortcut namein the Collection Aliasfield.

* A collection alias can be used to make searches easier for users; they may only
be made up of letters, dashes, and underscores (no spaces or odd characters).
Collection Aliasisthe name that is used to sort metadata, and is also used for
building queries when performing searches.

» The Collection Alias and the Pretty Name do not to beidentical.

9. Sdect afield format from the Display Format drop-down list.

» Theoptions are: Check Box, Password, Radio Buttons, Select, Multiselect, Text

Field, and Text Area.

Format Result
Check Box Creates a check box.
Password Creates a text box for entering a password. These are case sensitive,

and are encrypted into asterisks (*) as each letter is entered.

Radio Buttons Creates a "select one only" list of radio buttons. Button choices are
controlled by the Choices field.

Select Creates a drop-down list of selections. The selection choices are con-
trolled by the Choices field. If Height is set to 1, the result will be a
drop-down box. If Height is set to >1, the field is displayed as a list.

Multiselect Multiselect works like the select box in that it creates a drop-down list
of choices. However, the multiselect box enables users to select more
than one option within that selection box.

Adding Attributes
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Format Result
Text Field Creates an empty single-line text box.
Text Area Creates a larger, multi-line text box.

10. Select arestriction from the Restrictions drop-down list.
e Theoptions are: None, Read Only, and Required.

11. Enter aregular expression in the Domain field, if required. Regular expressions my
be used to control where an attribute is exposed.

12. Click on the appropriate check boxes in the Layout Specifics section.
13. Enter the appropriate text in the fields next to the check boxes that are checked.
14. Click on Next.

« The configured metadata field displaysin the Editing Form:

Display Mame Field Name {Alias) Format

— &> % Author Author Text Field

= ~l* % Date Date Text Field

= 173 Keywiords Keywords Text Field

= 7% Title Title Text Field

=~ QA 1 (QAT) Checkbox
Save | Revert |

15. Click on the Save button.

e The Editing Form disappears from the screen and you are taken back to the Col-
lection Information screen.

Modifying Attributes

This procedure allows the Site Administrator to modify the values of existing
metadata fields. You cannot modify System-created metadata fields.

1. Inthe Side Navigation Bar, click on the Attributes menu triangle to expand it.

w hlodify

2. Click on the Modify link.
e The Modify Attributes screen displays:

Display Mame Field Name {Alias) Format
=l==13] Author Author Text Field
=l=l=& Date Date Text Field
=ll=|3 Description Description Text Field
=== 3 Keywords Keswords Text Field
=== Title Title Text Field
=l=l=3 QA Status _t1 QAT Text Field

Sawe | Fesvert |
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Deleting Attributes

3. Click onthe % to theleft of the field name you want to change.
¢ The Attribute Settings screen displays:

Attribute Settings for _t1

Pretty Name IQA Status

Collection Alias |QA1

A ocollection alias can be used to make searches easier for human beings to read; they may only be made up of
letters, dashes, and underscores. The collection alias defaults to the name of the field in the collaction.

Display Format |TE>d Field =]

Restrictions INDHE vI

Darnain I [regular expression)

Layout Specifics: cheded items apply)
V¥ Wyidth |2|:|
[T Height |1
[T Choices =]

[orwe choice per
Tire))

[~
Mext » |

4, Makethe appropriate changes. (See “Adding Attributes’ for details concerning this
function).

5. Click on Next.
» The new configuration displays in the Edit Form screen:

Display Mame Field Name {Alias) Format
— &> % Author Author Text Field
= ~l* % Date Date Text Field
= 173 Keywiords Keywords Text Field
= 7% Title Title Text Field
= =175 QA Status QAT Radio Buttons
Save | Revert |

6. Click on the Save button.

» The Editing Form disappears from the screen and you are taken back to the Col-
lection Information screen.

Deleting Attributes

This procedure deletes a non-system metadata field from the entire database. System
fields cannot be deleted. Note: deleting a metadata field from the database
removes all associated information in that field for all documents presently in the
system and removesit from the search index. Therefore, deleting aafield that is
referenced in a search or metadata display elsewhere in the Portal may cause

InfoPortal 4.91




Deleting Attributes

unpredictable results. Before deleting afield, be sure to check to see that this removal
will not affect the functioning of the search, search display, and category views within
the Portal.

1. Click on the Attributes menu.
2. Click onthe Add/Déelete link.
» The Add/Delete Attributes screen displays:

Add ! Delete Attributes

1473 Text fields available Add |
12 Integer fields available Add |
12 Timestamyp fields available Add |

Hatme Database Mame (Alias)
Luthor Luthor

Charset Charset

Date Date

G CATEGORTY G CATEGORTY
G_COMNMENT G_COMNMENT

3 _CREATED 3 _CREATED

G LASTMODIFIED G LASTMODIFIED
5 _CORIGIMNAT 5 _CORIGIMNAT
G_RENDITION G_RENDITION

G _SIZE G _SIZE

3_TIRI 3_TIRI

Eeywords Eeywords
MIME-Tvpe MIME-Tvpe
MewsGroups MewsGroups

PPath WVdkVegwEey (FPath)
PageMap PageMap

Srippet Srippet

Title Title

To To

new_field t1 1 (AT

* System fields cannot be deleted
Delete Selected Field |

Click on the radio button for the attribute you wish to delete.
Click on the Delete Selected Field button at the bottom of the screen.
A warning appears asking if you are sure you want to delete the field

© 0k w

Click Yes
¢ Thefield isremoved from thelist.
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Changing the Order of Attributes

The Administrator can change the order in which metadata items appear in the list
(both in the Administration view and in the corresponding forms, such as the Add
Document view).

Table 1;

Icon

Function

Removes attribute from form

Moves attribute up one line

moves attribute down one
line

Opens Edit Attribute screen

To move an attribute up or down, select the appropriate button next to the attribute. To
move an attribute up five positionsin thelist, you must push the button five times. The
screen will refresh after each action. You must SAVE the attribute set after you have

completed moving the attribute.
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Batch Indexing Documents

This procedure indexes a group of documents. InfoPortal will recognize and organize
the documents and metadata (if any) that is associated with them.
1. Click on the Batch Operations menu.
2. Click on the Index link.
¢ TheIndex Documents screen displays.

Index Documents

=elect files for batch indexing.

¢ ‘fou may view the list of documents generated and then choose to either finish the process or
clear the index cache by pressing the appropriate buttons at the bottom of the screen. Or, you
may select the "Suppress listing” checkbox below, which will prevent the files being indexed from
appearing on the next screen, and then select to finish the process or clear the index cache.

¢ The regular expression provided will index any documents with the file extensions listed below. To
exclude any given file typels) from the indexing process, delete the extension in the list below.

Base URL: |f

Regexp Match: |"-,.(htm|b-ct|pdf|html|gif|jpg|jpeg|du:u:|rtf|5am|wri|5gml|
Recurse over Subdirectories: [0
Suppress listing: [0

Select Documents |

3. Click inthe Base URL text box.
Enter the URL where the documents to index are located.

5. If you want to exclude any file type(s) from the indexing process, highlight and
delete the extension(s) in the Regexp Match text box. Likewise, if you wish to add

Depending on the any filetypes, add their extension after a pipe but within the parentheses of the
number of documents expression.

being indexed, and o . . . . oo
eIng Inceed, an 6. Click inthe Recurse over Subdirectories check box if you want to include filesin

their size, this process ) . . .
could take anywhere subdirectories of the URL in the Base URL field.

»

Note

from several seconds 7. Click the supresslisting box if you do not want to to see alist of the documents that
to some minutes InfoPortal is preparing to index.
(hours, in extreme 8. Click on the Select Documents button.

cases). Do not perform
large Batch Index pro-
cesses during heavy
usage times.
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* The Selected Fileslist displays: (if supress listing has not selected)

Selected Files

Scanned documents from f.

The bulk insert data structure currently contains:

diglyphicaidocs
Charset 250
G_LOID 0007000000001 25
G_ORIZINAL fhorn.gif
G_RENDITION
G_URI fhorn.gif
MIME-Type image/lgif
FFath diglyphicaidocsihorn. gif
Fagehap 0=
diglyphicahdocshindexed
G_LOID 0007F000000000f14
G_URI !
MIME-Type textieempty
FFath diglyphicatdocsivindexed
Fagehap 0=
d:glyphicatdocsthorn.gif
Charset 250

G_LOID 0007000000001 25
G_URI fhorn.gif
MIME-Type image/lgif
FFath diglyphicaidocsihorn. gif

Fagehap 0=
Index Selected Documents Clear Bulk Insert Data Note
Do NOT use the Back
9. If thedocuments listed are not correct, click on the Clear Bulk Insert Data button button to restart the
and modify the document path. Select Documents pro-
10. If the documents listed are correct, click on the Index Selected Documents button. cess. Clear first, then

restart the process.
Otherwise, theoriginal
incorrect datawill be
held in memory.
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» The Collection Information screen displays with messages telling you when
indexing begins.

Collection Information

Indexing begun; bulk submit data cleared. Indexing the documents may take some time; they may
not yet be available for searching and metadata access.

InfoPortal's search engine is the Verity Developer's Kit version 2.5.1 patch level 0.

Information About Resources
Total Documents O NHame Value
Craated ;Fgf_lzrészaay, August 2B 1993, Charset 8859
e Country L=
: Thursday, September 16 Dialect us
Last Modified 556 153525 alec
Language en

Locale Mame english 3859
hajor Wersion 1
Minar “ersion O

Supplier

e Depending on the number of documents, this process may take some time. for
windows NT users, you can watch the CPU utilization on the server using Task
Manager. CPU utilization will run near 100% until indexing is complete.

Batch Versioning Documents
This procedure creates a version history for agroup of documents.
1. Click on the Batch Operations menu.

2. Click on the Version link.
» TheBatch Versioning screen displays:

Batch Versioning

=elect files for batch versioning.

Base LURL: |¥

Recurse over Subdirectaries: [T

Select Documents

3. Clickinthe Base URL text box.
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Enter the URL where the documents for batch versioning are located. (Example: /
Sales/Contacts)

Click in the Recurse over Subdirectories check box if you want to include filesin
subdirectories of the URL in the Base URL field.

Click on the Select Documents button.
» TheBatch Versioning Preview screen displays.
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* You may uncheck any documents you do not wish versioned at thistime.

Batch Versioning Preview For

!
Comment: IBatch Versioned
SUMMary: “ersion |
Total files listed: 8 (47722 bytes)

Passed access test: 8 (47722 bytes)
Failed access test 0 {0 bytes)

M File: findex. htrl

Access Test: Passed

W File: Mvestcomlogo. gif

Access Test: Passed

W File: MestcomBanner. gif

Access Test: Passed

¥ File: fEastcombogolMew. gif

Access Test: Passed

¥ File: {Eastcombogo. gif

Access Test: Passed

¥ File: fEastcomBannerMew. gif

Access Test: Passed

¥ File: {EastcomBanner. gif

Access Test: Passed

¥ File: Aelcome fm

Access Test: Passed

7. Click on the check box to the left of the file name for files you do not want placed
under version history control.

8. Click on the Version button.
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Importing Documents and Metadata

» TheBatch Versioning Status screen displays to show the success/failure of the

versioning process.

Batch Versioning Status For

success #:8
Failed # 0

versioned Snde: himl
SUCCESS

versioned AMestcomlogo.ogif
SUCCESS

versioned MVestcomBanner. gif
SUCCESS

versioned /Eastcombogolew. gif
SUCCESS

versioned /Eastcombongo. gif
SUCCESS

versioned /EastcomBannerew. oif
SUCCESS

versioned /EastcomBanner gif
SUCCESS

versioned SVelcome.fin
SUCCESS

This procedure imports large databases of documents into InfoPortal from an existing
document management system or document inventory. The procedure consists of two
parts:

Creating a spreadsheet for the documents and exporting it to atab- or comma-delim-

ited text file

Importing the metadata for the documents
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Preparing for Import

4.100
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Preparing for Import

To prepare for metadata import, you create a tab- or comma-delimited text file or
spreadsheet (with the .txt extension) from the database.

1
2.

© N O

Determine the names of the metadata fields to be imported.

Add thefieldsto the InfoPortal database. The collection Alias should match the col-

umn headings in the spreadsheet (or visaversa).

Place the documents to be indexed into the file system folders where they will reside

in the InfoPortal.

e UseWindows NT Explorer or another file management system to do this. DO
NOT use the Add Document function in InfoPortal or WebDAV.

Create a spreadsheet containing the metadata.

* You can do this manually or from an existing database. The column headings
should correspond exactly to the field names as set up in the InfoPortal. For
example, a Collection Alias called Country_Name in the InfoPortal must be
mapped to a column in the spreadsheet called Country _Name. Note that this
must be the Collection Alias, not the “pretty” (display) name. The import will
not work if the names do not match exactly.

Create adl the pertinent metadata fields.

Thefirst column in the spreadsheet should be called Filename.

Place the full document path and filename in this column for each document.

Export the spreadsheet to atab-delimited text file on the InfoPortal server.

» Thefile should be stored outside of the document root directory, but must be on
the same server as the InfoPortal installation. Save the file as tab-delimited text
when exporting.

Importing metadata

After you create the tab-delimited text file from the database for the documents, you
use InfoPortal to import the metadata.

1
2.

Click on the Batch Operations menu.
Click on the Import link.
» Thelmport Metadata screen displays:

Import Metadata

=elect a file for metadata import, and pick a base URL to pravide a physical path for
camparison. {If your server has only one docroot, use «) You will have a chance to review the
metadata befare indexing it into the collection.

Metadata Filel Browse...

Base URL |/
Data format ™ Tab-delimited © Comma-delimited

3.

¥ Strip double quotes
Import Metadata

Click on the Browse button.




4, Select the metadatafile.
5. Setabase URL.

« Usethe/ toindex documents in the root document directory. Otherwise, specify
aserver directory. If the server contains multiple document directories and/or
subdirectories, enter a path that will directly point to the documentsto be
indexed.

* You need to use something other than a base URL only if you have a nametrans
(Netscape) or avirtua directory (11S).

6. Click on the Tab-delimited radio button in the Data format field if it is not aready
selected unless the imported metadata is in comma-delimited format.

7. Click on the Strip double quotes check box in the Dataformat field if it is not
already selected.

» Thiscan prevent problemsin the datathat could be caused by quotation marksin
the spreadsheet.

8. Click the supress listung check box to avoid viewing alist if documents being
imported (recomended for imports).

9. Click onthe Import Metadata button.

10. Check the resulting Selected Files screen to make sure that the data to be imported
into the specified fieldsis correct, and that the paths to the documents is correct.

e Check especially for places where afailure to place double backslashesin the
path has resulted in an incorrect path.

11. If theinformation in the Selected Files screen is correct, click on the Index Selected
Documents button.

* Indexing beginsimmediately.
12. If theinformation in the Selected Files screen isincorrect, click on the Clear Bulk
Insert Data button and troubleshoot the spreadsheet.

Exporting Metadata

This procedure exports metadata from the system for use in reporting or importing
into other processing systems. You can select the fields to export.

1. Click on the Batch Operations menu.
2. Click onthe Export link.

Exporting Metadata

Note

Do NOT use the Back
button to clear the bulk
insert data. Use the
Clear Bulk Data but-
ton first, then restart
the process. Other-
wise, the original
incorrect datawill stay
in memory.
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Exporting Metadata

» The Export Metadata screen displays:

Export Metadata

Pick a URL from which to export metadata. The metadata will be sent under the MIME type
application-download; save it in your local filesystemn when the dialog box appears.

Base URL [

[T Recurse over Subdirectories

Select Exported Fields |‘v’i5ih|e fields j

V¥ Author V¥ Date W G CATEGORY W G _COMMENT
M G_ORIGINAL M G RENDITION M G URI M Keywards
W MewsGroups W Snippet W Title W Ta

Expaort Metadata |

3. Enter the directory for the Base URL.
 |f you choose the default, metadata will be exported for the directory correspond-
ing to the Base URL for the InfoPortal and al filesin that directory. As another
example, /Countries/Chinawill export only the data for the group of documents
listed in the Countries/China sub-Category.
4. Click on the Recurse over Subdirectories check box.
5. Thisforcesthe export engine to include metadata included in subdirectories of the
Base URL.
6. Click on the Select Exported Fields drop-down list.
7. Select asubset to export.
« Options: Visible fields, Writable fields, Mandatory fields.
8. Click on the check boxes to uncheck any of the metadata fields you do not want to
export.
9. Click on the Export metadata button.
« A browser message displays:

Unknown File Type E3

gy 10U have started to download a file of ype

s application/download

S Click "More Info" to learm how to extend Mavigator's
capahilities.

Pick &pp... Save File.. Cancel

10. Click on the Save File button.
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Deleting a Web Link

* The Save Asdialog displays:
Save As. . i E3
Save I |El Downloads j ﬂl

File name:

Save I
Save az hupe: IF'Iain Tt [*.kat] j Cancel |

11. Select the location to save thefile.
12. Click on the Save button.

e The system savesthefilein the location you specify. Then you can useit to re-
import into the system or manipulate the data for reporting or analysis.

Deleting a Web Link

This procedure removes an existing Web Link from the InfoPortal. Any users with the
proper permission to the directory containing the Web Link can delete them. This
procedure is performed in the Content Publishing view.

1. Select Content Publishing from the Top Navigation Bar.

2. Navigate to the Web Link location on the InfoPortal.

3. Click on the Web Link icon to select it:

= hitpdwrwew slvphica com Glyphica Products

4. Inthe Side Navigation Bar, click on the Edit menu triangle to expand it.

5. Click on the Delete link.
« A confirmation message displays.

206.86.239.42 - [JavaScript Application] [E3

@ Delete Glvphica Products?
Eancell
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Adding Mailbox Forwarding

4.104
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6. Click onthe OK button.
¢ TheWeb Link isremoved.

Adding Mailbox Forwarding

Mailbox Forwarding acts as afilter, making sure that the contents (emails and
attachments) are routed to the appropriate mailbox.

This procedure configuresthe criteriaby which mail will be forwarded from a selected

mailbox to another mailbox.

1. Navigateto the directory in which the Mailbox folder islocated.
2. Click on the Mailbox folder to select it.

1EH s Sales Mailbox

3. Inthe Side Navigation Bar, click on the Mailboxes menu triangle to expand it.

Mailboxes

# Add Fonwarding
# e Fonvards

4. Click onthe Add Forwarding link.
e The Create Mail Forwarding screen displays:

Create Mail Forwarding

Any mail arriving at the source mailbox which matches the destination criteria will be
delivered ta the destination mailbox instead.

Forwarding Name |admin's fonwarding
Source Mailbox /Sales%20Mailbox. mbx
Destination Mailbox |

Forwarding Criteria

HeaderlFrnm: =l |Equa|5 =l
[T Case-sensitive

Create Filter |

5. Changethetext in the Forwarding Name field if you wish.

e The Source Mailbox field is read-only; the data shown hereisthe filename of the

Mailbox Folder you selected in Step 2.

6. Enter the directory path and filename of the mailbox to which you are going to for-

ward mail in the Destination Mailbox field.

7. Click on the first Header drop-down list and select the message header criteria. The

following are the header elements you can select:
e From, To, Subject, Sender, Reply-To, CC, Mailing-List

8. Click on the next drop-down list to the right and select a comparison operator. The

following are the avail able choices:
e Equals, Does not Equal, Contains, Begins, Ends

9. Enter Forwarding Criteriatext in the text box to the right of the two drop-down lists.




Viewing Mailbox Forwards

10. Click in the Case-sensitive field if you want the Forwarding Criteriato be case-sen-
sitive (that is, “Criterid’ is considered to be different than “criteria’).

11. Click on the Create Filter button.
« A confirmation message displays:

Created filter natned 'marketing forwarding'.

Viewing Mailbox Forwards

This procedure displays the Mail Filters screen, aread-only screen that liststhe
current mail forwarding criteria set for a selected Mailbox folder. Only the Site
Administrator can change the mail forwarding criteria onceit is set up.

1. Click on aMailbox folder icon to select it.
1EH s Sales Mailbox

2. Click on the Mailboxes menu triangle to expand it.

Mailboxes

# Add Fonwarding
# e Fonvards

3. Click onthe View Forwards link.
e TheMail Filters screen displays:

Mail Filters

Filter name Destination Mailbox
marketing forwarding  /Marketing/Marketing Mailbox. mbx
Filter (message. getHeader(To). searchifarketing$i) == 0)

e This screen displays the name of the filter, the location to which mail is for-
warded (Destination Mailbox), and the Forwarding Criteria that has been imple-
mented (Filter).

Starting a New Discussion

Discussion Groups are a place for Content Publishers to hold threaded forums on
relevant topics. They are created inside Category folders, and are treated as content
within those folders; these discussions are searchable and any documents attached to
postings within the discussions are also searchable as part of the system content.

This procedure creates a Discussion folder on your Portal. Only Site Administrators
and Account Administrators can create new Discussion folders. Whilethisis
discussed as a site Adminisrtator function, the site Administrator or Account manager
must be in Content publishing mode to use this function.

1. Select Content Publishing from the Show drop-down list.

2. Navigate to where you want to locate the Discussion folder.
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Deleting a Discussion Message

3. Inthe Side Navigation Bar, click on the File menu triangle to expand it.

4. Click on the Discussion link.
¢ The New Discussion screen displays:

Mew Discussion

Your Marme: adrmin
Email Address: TBD

Title: | Fost |

5. Enter thetitle of the Discussion in the Title text box.
6. Click on the Post button.

» Thediscussion folder is created in the current directory:

F ¥

< home ; Portal Info : Ideas for Portal Content :

ldeas for Portal Content

There are currently no topics in this discussion group.
To add a topic, please use the discussions menu.

Deleting a Discussion Message

This procedure removes an existing Discussion Response message and attachment, if

any, from the Discussion Window. Only Site Administrators can delete messages and
attachments.

1. Navigate to the appropriate Discussion Group folder:

home : Tranng Documents

l‘ -
© » Training Documents
Training Documents

:?—'—_; suoeestions for Traming Topics

il

=) LTraring Format Preferences

e

{

2. Click on the appropriate Discussion folder link.

¢ Alternatively, you can view all discussions and click on the appropriate Discus-
siontitlelink. See “Viewing aList of All Discussions,” page 3.63 for details.
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Deleting a Discussion Message

» The Discussion Group topics display:

home : Tranng Documents ;. Sugeestions for Tramme Topics

Suggestions for Training Topics

2 File/Folder Permissions gulie)wed, 25 Aug 1999 00:43:10 GMT

2 Aftributes gadaed, 25 Aug 1999 00:53:17 GMT

S5 Docurment Review Process ¢mand ived, 25 Aug 1999 00:52:37 GMT

S A0ENtS Gohn)Wied, 25 Aug 1999 01:.00:923 GMT

0

3. Click on thetopic link containing the message you want to delete.
» The Discussion window displays:

Discussion

GLYPHICA 4.¢.;

Suggestions for Training Topics

File/Folder Permissions (juliz) wed, 25 Aug 1999 00:48:10 Gha”

. Full Day Session (david)wed, 25 Aug 1999 12:50:02 GMT

" £ S—

[ == |Dacument: Done

4. Inthe left-hand window, click on the link for the message you want to del ete.
5. The message content displays in the right-hand window.

6. Click on the Delete button in the Navigation Bar.
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Deleting a Discussion Message

» A confirmation message displays:

206_86.239.42 - [JavaScnpt Application] E

@ Are pou zure you want to delete thiz mezzage?

Caticel |

7. Click onthe OK button.

* The message is deleted. The attachment, if any, is also deleted.
e Themessage link is removed from the left-hand window:

GLYPHICA

Suggestions for Training Topics

File/Folder Permissions [julie] Wed, 25 Aug 1999 00:45:10 GMT Author: dawid
Fosted on: | Wed, 25 Aug 1999 01:12:05 GMT
Subject: Full Day Session
Attachrment:

There's enough here for a full day session. |
suggest we split it into concepts in the
morning and scenarios in the afternoon.

" £ w—

[ == |Dacument: Done

¢ Even though the message text remains in the right-hand window, the message is
in fact deleted from the Discussion Group. (You can verify thisby clicking on the
Next Message button, then the Previous M essage button in the Navigation Bar).
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